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This guide was created to assist Artists and Engineers, to learn the basics of 
mesh modelling of non deformable objects with 'Blender'. It uses a structured 
approach to introducing Blenders tools and work-methods. Following the 
guide should enable you to become familiar with blender and create models 
from the simplest of parts to complex accurate engineering assemblies and 
designs. 

The guide focuses solely on Blenders Mesh Modelling capabilities, it ignores 
the myriad of animation, texturing and photo-realistic rendering tools and 
concentrates solely on getting started and producing accurate models suited 
for both artistic and engineering purposes.

The guide was originally made as a series of web pages that documented the 
design ideas and Blender methods used do design a few of the components I 
will be making for a rebuild of my CNC router. It has been ported to this .pdf 
book from the web pages, so some references in the guide will still only relate 
to the on-line version. 

The Small Print

This guide is provided as a free reference to new and existing Blender users. The contents of 
the guide are copyright  Robert Burke © 2007, but permission is granted for you to store a 
copy on your computer or print a hard copy for personal use only. You may not use this guide 
for any commercial purposes without written permission. (I have donated my time and knowledge 
free to produce the guide, I don't expect people to make money from it)

THIS GUIDE IS PROVIDED "AS IS" AND WITHOUT ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, 
WITHOUT LIMITATION, THE IMPLIED WARRANTIES OF MERCHANTIBILITY AND FITNESS FOR A 
PARTICULAR PURPOSE.
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There is a wealth of information available on the Internet in the form of 
manuals, guides and tutorials that cover the full potential of this program. This 
Guide is intended as a starter for people interested in the creation of mesh 
models and more specifically, dimensionally accurate mesh models. Appendix 
1 gives a short list of useful Internet links.

Obtaining and loading Blender

The Open Source and freely available creative package Blender can be 
downloaded from www.blender.org. Once on the site, click the download link 
to open the download page. Choose the file to suit your operating system and 
follow the simple installation instructions at the bottom of the download page 
to install the program.

What you see when the program starts

When you run blender for the first time you are presented with the default 
screen. It contains the user preference’s window at the top of the screen. The 
main 3D work area in the centre of the screen and the buttons window at the 
bottom of the screen.
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Relevant sections of the program

When you first start modelling, the main two screens are already open, the 3D 
workspace and the Buttons window. A cube object (1) is in the centre of the 
3D view and the window is orientated so you are looking down onto the top of 
the cube. There is also a Lamp (2) to illuminate the cube and a Camera (3) to 
output a 2D bitmap of the cube.

3D View: Header Bar

At the bottom of the 3D view is blenders View Header Bar. The purpose of 
each section within the view header is detailed below.

2) Pull up menu
A context sensitive menu showing the operations that can be carried out and 
the keyboard shortcut for the operation.
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1) Window Type

Click on the window type button and a menu 
will appear showing all the different window 
types. Each window has a function within 
the process of 3D modelling, image creation 
or animation. However our initial interest lies 
just with the following windows:

3D View:

Buttons Window:
This contains Blenders control 
buttons.

Outliner: 
A structured view of objects within the 
3D scene and there relationships to 
each other.

Script Window: 
To run useful add on scripts.

A Quick Overview of the controlls.



Buttons Window Header Bar

Context Buttons:
These change the control button options in context with the operation you are 
performing.
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3) Mode:

The operating mode for the window, initially 
we will only be using Object mode and Edit 
mode.
Object mode is where assemblies of 
components are constructed.
Edit mode is where the individual 
components are modelled.

4) Draw type

This is the way the model is displayed on 
screen. The two useful types we are 
interested in for modelling are Wireframe 
and Solid.

5) Pivot Point

This gives a choice of centre points for 
rotating and scaling the 3D models.

6) Widget control

Click the hand icon to de-select this. It 
should show a light grey background

7) Layers

These allow you to organise components in 
big assemblies, only showing those that are 
needed.



8) Material Context Button
Brings up a choice of material texturing and lighting options.

9) Editing Button
Brings up the modelling tools.

10) Render Button
Controls the output to a 2D-bitmap image.

11) Material Sub-context
Each context button has sub context options.

Understanding 3D co-ordinates and Blenders 3D views

When you first run blender you are presented with a view of the workspace 
looking directly down from above. The screen in this position represents the X 
and Y-axis. The Z-axis is coming away from the screen directly towards you.

You can change the view direction by either clicking and holding the middle 
mouse button whilst dragging the mouse to rotate the view around a point in 
3D space, or using one of the pre-set views accessed via the number buttons 
on the right of the keyboard. (Num Pad Buttons)

When modelling in blender you draw parallel to the surface of the view at the 
depth of the 3D Cursor (small cross hair positioned by clicking the Left Mouse 
Button), so the view rotation and position of the cursor is important to the 
desired outcome.
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Cartesian Co-ordinates

Blender uses the right hand co-ordinate 
system with the Z-axis pointing upwards. This 
is in common with the co-ordinate systems 
used by most common 3D CAD packages. Its 
worth noting though, that some programs use 
a co-ordinate system where the Y axis points 
up and it may be necessary to rotate the 
model if exporting your model into a program 
with this configuration.

Blender displays the co-ordinate as:
DX 0.0000 DY 0.0000 DZ 0.0000 (0.0000)
When moving or extruding a vertex the 
bracketed figure denotes the distance from 
the start point and DX, DY, DZ will change 
relative to the distance along the axis relative 
to the start point.

In object mode The Transform Properties 
pane, accessed by pressing the N key, 
displays the objects position, relative to the 
global co-ordinates. It also gives details of its 
rotation, scale and bounding box size. The 
object centre co-ordinates of the blue cube in 
the Cartesian co-ordinates diagram are 
displayed in the Transform properties 
window.



In order to make blender units represent a real world unit it is necessary to 
assign a dimension size to the blender unit. When Blender first opens you are 
presented with the default cube measuring 2 blender units wide by 2 blender 
units deep by 2 blender units high. When importing a VRML or STL file into a 
rapid prototyping machine it is necessary to tell the software what dimension 
the units represent. So in order to manufacture an accurate 3D model in 
Blender and export it to a 3D printer or CNC machine, you need to know what 
the blender unit represents as a real world measurement.

The 3D world within Blender isn’t an unlimited space and there are restrictions 
as to how big a model can be. Size is limited by the available power and fall-
off distance of the lights, the maximum clipping distance of the view camera 
and the maximum clipping distance of the render (output) camera. Complexity 
of a model is limited by the amount of vertices your system can handle. The 
more powerful a machine you have the more vertices you will be able to 
handle before the computer starts to lag behind the speed you can model at.

So how big should I make a blender unit?
If you were considering modelling a precision component or assembly, being 
able to model down to sub micron accuracy would be a distinct advantage. So 
if we consider one blender unit to equal one millimetre how accurate can we 
get? Blender allows you to numerically input the distance of vertices to the 
precision of 4 decimal places (0.0000).  Say you extrude a vertex 0.0001mm 
along the X-axis you have set its position 1/10th of a micron from the original. 
Pretty darn accurate and given that the best CNC machining centres can 
position to an accuracy of plus or minus 3 microns, you can model to a much 
greater accuracy than you could ever manufacture to. The draw back to this is 
your viewable workspace will be limited to a cube with 10 metre sides. This is 
due to the clipping limit of the view camera, but unless you are designing a 
gantry mill to cut the wing spars for an Air-Bus A380 this shouldn't present a 
problem.
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Putting Size into Perspective

♦ The human hair is around 76 microns thick.
♦ Most general purpose machine tools in 

skilled hands would be able to work within 
two thousands of an inch (50 microns)

♦ The best CNC machining centres can 
position to an accuracy of plus or minus 3 
micron, with repeatability of plus or minus 1 
micron.

♦ A 100mm-iron bar will expand 0.012mm with 
a rise in temperature of 10 degrees C

Other scales could be chosen for precision work such as 1 blender unit = 
10mm giving a work area of 100 cubic metres, however this confuses the 
process and you constantly need to be aware of where the decimal point goes 
when you are entering extrude lengths etc.

For architectural designs it is common to use a scale of 1 blender unit = 1 
metre allowing a viewable design space of 10 cubic kilometres and an 
accuracy of 0.1mm
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When blender first opens the view has a cube object in the centre. This is one 
of several primitive shapes available to you that can be altered to form your 
component. In Object Mode the shape appears as a solid cube and you are 
limited to being able to move its position within the global space, rotate it 
about a chosen point or scale the whole model. By pressing the Tab key you 
enter Edit Mode and the corners of the cube now have a yellow dot on them, 
connected by yellow edges. The yellow denotes the vertices are selected. In 
edit mode you can move the position of any selected vertices, add, join or 
delete vertices, fill the area between any three or four vertices with a face and 
much more to construct your model.

Object Mode - Solid View

Cube (1) is selected with focus. If you 
press Tab this cube will become 
available to edit in edit mode.
Cube (2) is selected.
Cube (3) is not selected

Object Mode - Wire View

Cube (1) is selected with focus. 
Cube (2) Is selected.
Cube (3) is not selected.

Edit Mode - Solid View

Cube (1) All vertices selected.

Cube (2) No vertices selected.
Cube (3) One vertex selected. Note the 
edges fade from yellow selected end to 
black deselected end.

Edit Mode - Wire View

Cube (1) All vertices selected.

Cube (2) No vertices selected.
Cube (3) One vertex selected
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Blender has a wealth of tools that allow you to model almost anything and 
these will be described in the following tutorials. If you are new to 3D, work 
through the tutorials in sequence; drawing methods and the use of tools are 
introduced and described as the tutorials progress getting less detailed as 
your experience progresses. If you get stuck, simply go back through the 
tutorials to where the tool or method you are struggling with was introduced. 
The initial description of the process will be the most detailed and helpful.

Modelling a 608 Bearing

Part 1 - Laying out the reference geometry.
Part 2 - Detailing the bearing Race cross section.
Part 3 - Adding the Ball Bearings.
Part 4 - Modelling the Bearing Cage.
Part 5 - Detailing the Bearing Cage Securing Clasp.
Part 6 - Adding the Dust Shield.
Part 7 - Modelling the CirClip
Part 8 - Low vertices version bearing.
Part 9 - Rendering the Bearing.
Part 10 - Creating a Page Template.
Part 11 - Laying out scale drawings

With the experience of modelling the Bearing its time to put the Bearings to 
use. The next tutorial constructs a V-roller and Axle that will be used to run on 
the Guides of my CNC machine.

Building A V-Roller Guide Assembly

Part 1 - Modelling the V-Roller.
Part 2 - Constructing the axle, washer and nut.
Part 3 - Producing Detailed Threads.
Part 4 - Laying out the Assembly Drawing

If you have completed in sequence all the tutorials above you should now be 
comfortable with Blenders way of modelling. This next part looks at 
positioning the V-roller's alongside other components and designing a casting 
around them. The casting will form the X-axis of my CNC router.

Design Steps for a Casting

Part 1 - Laying out the components
Part 2 - Initial casting design
Part 3 - Support Brackets
Part 4 - Completing the casting
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To introduce you to Blenders modelling tools I will walk through the process of 
designing a 608 Bearing, the type used in skateboards and in-line skates. The 
geometry from the bearings will later be used in the design of the other 
components and castings. 

I will use this tutorial to introduce some of the basic modelling techniques that 
can be used to build components accurately. Two bearings will be covered in 
the tutorial, a detailed model with a large number of vertices and a low 
detailed one with substantially fewer vertices for use on slower computers or 
for use in large assemblies. The low detailed model will still be dimensionally 
accurate.   

First of all, I think a brief description of what we 
are about to model and how we will go about it 
is in order. Its always better to plan what you are 
doing before you start, rather than leaving it to 
chance as you work through your ideas. This 
model won't be used to manufacture the 
bearings so I am only concerned with the 
internal diameter, external diameter and width of 
the bearing being accurate, the rest is open to 
some artistic interpretation.

The method to create the shell of the bearing 
will be to draw a cross section of the inner and 
outer race relative to the centre of the bearing 
and then spin this through 360 degrees.

We will work to a scale of one blender unit equals one millimetre. Nothing has 
to be set in blender to achieve this, just always remember for this tutorial 
every dimension you input is in millimetres.

Keyboard and mouse actions will be shown in bold type

Open blender, you will be presented with the default top view 
looking down onto the top of a cube object. In the bottom left 
corner the co-ordinates arrows show the directions of the axis.

Press and hold the MMB (middle mouse button) and drag the mouse around 
to rotate the viewing direction, the other sides of the cube will then be seen. 
You can pan the view by holding down the Shift key whilst pressing the MMB 
and moving the mouse The top view can be reset at any time by pressing 
NumPad-7 (Top View). If you loose your cube from the view you can retrieve 
it by pressing the Home key.

When we draw our bearing we need to orientate the model so the front face of 
the bearing is shown when we press the front view. The first part of the 
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process is to draw a section through the bearing perpendicular to the front 
face, therefore we need to draw on the side view.

Press NumPad-3 (Side View). The position of the cameras 
and light will change in the view and the co-ordinate arrows 
will change to reflect the different axes positions.

If you press N on the keyboard the Transform 
Properties window will open. This gives details of 
the location of the object within the 3D co-ordinates, 
the rotation around its centre point, any scale 
applied to the object and the size of its bounding box 
(box that encloses the object).

The red green and blue arrows in the centre of the 
cube object can get in the way when precision 
modelling. Press the hand icon on the Transform 
Properties panel of the view header.

The options in the Transform Properties panel will 
change and the hand icon will turn white. The arrows 
will be removed from the view.

We need an object to build our model on but the cube 
isn't very useful for the bearing so we will delete it. 
Press the X key to bring up the delete menu and 
accept the pop up menu option. The cube will be 
removed from the screen leaving the cursor in the 
centre of the global co-ordinates. Cursor position X0.0000, Y0.0000, Z0.0000

In order to draw our bearing we need an object with at 
least one vertex. For this we will insert a Plane.

Make sure you are still in side view NumPad 3 then 
press the Space Bar to bring up the Toolbox, as we are 
adding a mesh object, move the mouse over "Add" a 
sub menu appears, move the mouse over  "Mesh", 
another list of options will appear, click on "Plane".

A Plane will be created, centred on the cursor and the view 
will have switched to Edit Mode to allow you to edit the 
plane.
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As we need to work from one vertex centred on the cursor, 
press the A key to de-select all the vertices which will turn 
them grey and the edges black. Hold the SHIFT key to 
multiple select three vertices with the RMB (right mouse 
button).

Press the X key to bring up the 
delete menu. In edit mode, there 
are more options available than 
object mode.

Select "Vertices" and the three 
selected vertices will be removed 
from the view along with the face 
and edges of the plane. A single 
vertex will remain in the view and 
the Planes object centre will 
remain centred on the cursor.

In Edit Mode you can undo any changes you make by 
pressing Ctrl-Z

With the RMB click on the remaining vertex to select it, it will 
now turn yellow. We need to snap this vertex to the cursor 
position
 
Press SHIFT-S together to bring up the snap menu and select, 
Selection>Cursor. The vertex will now snap to the cursor position, however it 
can't be seen as the object centre hides it.

A 608 bearing has an inside diameter of 8mm 
therefore if the object centre is on the centre axis 
of the bearing we need to position the inner race 
4mm from the object centre.

Press E to extrude the vertex then press Z to 
constrain the movement of the vertex to the Z-
axis then press 4 the vertex will extrude 4mm 
along the axis. Press Enter to accept the move.

An edge has now appeared coming from the object centre to the mid point of 
the inner race.
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The width of a 608 bearing is 7mm so from the 
centre point we need to extrude an edge 3.5mm 
along the Y-axis.

Press E to extrude, Y to constrain it to the axis, 
-3.5 to set the position 3.5mm along the negative 
Y-axis and Enter to accept.

The second edge will now have appeared.

Repeat the extrude process for the other sides of 
the bearing.

The dimension between the inner and outer race 
is 7mm so:

Press E to extrude, Z to constrain 7 to position 
and Enter to accept.

Extrude the outer diameter 7mm along the Y axis.

Extrude the other side of the bearing -7mm along 
the Z axis.

You should now have the shape opposite in your 
view.

With the RMB Select the vertex under the cursor 
and then SHIFT-RMB the vertex directly above, 
so both are selected. These are no longer 
needed so press X and delete Vertices
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Select the two bottom vertices Shift-RMB and press 
F (face) to add an edge between them

We have now created the reference geometry to construct the detailed cross 
section of the inner and outer race relative to the centre axis. Blender has the 
ability to show the length of any selected edge. To activate it go to the buttons 
window at the bottom of the screen.

Click the Editing Context button (1) to bring up the edit buttons.

In Edit mode the buttons panels below will become available spread 
horizontally along the bottom of the screen. It may be necessary to drag the 
button panels to the left to see all the options. Pressing the MMB and 
dragging can do this.

In the Mesh Tools 1 panel (2) select Edge Length and the view will display the 
length of any selected edge.
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The bearing has a 0.6mm fillet on the edge of the 
inner and outer race. As Blender is not primarily a 
CAD program it doesn't yet have a dedicated fillet 
tool. However it is both quick and simple to add a 
fillet using the Spin function (3) in the Mesh Tools 
Panel

First we need to add a vertex at the start point of 
the fillet and also at the centre of the fillet. The spin 
tool works in the clockwise direction so it is 
important to take this into account when positioning 
the first vertex.

Starting in the bottom left corner, select RMB the 
corner vertex. Press E to extrude, Y to constrain to 
the Y-axis, 0.6 for the length and Enter to accept. 
This has created the fillet start vertex. With the new 
vertex still selected, Extrude E, Constrain Z, and 
length 0.6 and accept Enter. The fillet centre has 
been created.

Repeat this sequence in the other corners.

Select RMB the top left vertex, E, Z, -0.6 and 
Enter. Then E, Y, 0.6 and Enter.

Select RMB the top right vertex, E, Y, -0.6 and 
Enter. Then E, Z, -0.6 and Enter.

Select RMB the bottom Right vertex, E, Z, 0.6 and 
Enter. Then E, Y, -0.6 and Enter.

Your view should now look like the image opposite.

Starting in the bottom left corner select RMB the 
vertex on the centre point of the fillet

Press Shift - S to open the Snap menu and select 
Cursor -> Selection. The cursor will be positioned on 
the fillet centre.
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Now select RMB the vertex that will be spun to form the 
fillet.

In the Mesh Tools panel make sure in the text box 
below the spin button Degr: 90 is displayed. 
Change the Steps: 9 to Steps: 7 as we don't need 
that many vertices to scribe the fillet. Clicking on the 
small arrow either side of the “Steps:” text box, or 
pressing Shift and clicking over the number with the 
LMB (left mouse button) can alter the number. You 
can then use the keyboard to enter the number.

Press the Spin button and the first fillet will be created.

Repeat the process on the other corners

Select RMB centre vertex. Shift-S cursor-
>Selection. Select RMB the vertex to spin. 
Press Spin in Mesh Tools panel.

The vertices of the fillets are the first part of the 
bearing section that we will keep; the other 
edges are only there as drawing aides and will 
be removed later.
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We now have the Inner diameter, outer diameter and width of the bearing 
cross section positioned accurately above the centre axis, together with the 
corner fillets. The four corner vertices and edges we have created are only 
reference points, which we will use to position the detail needed for the inner 
and outer race.

This is a good time to save your work. Blender 
handles this slightly different to other 
programs, a good description of the process 
can be found on the Blender Wiki.  For now 
though press File - Save As. The 3D view will 
change to the File window. Choose the folder 
where you want to save your file and name it 
as 608-Bearing.blend Click Save File and the 
screen will change back to the 3D Window.

When you first use blender it may seem this is a slow and cumbersome way 
of drawing, but as you get used to the concept and the keyboard short-cuts 
become instinctive it is extremely fast. I have timed myself and from clicking 
the Blender icon on my desktop to load blender, to reaching this stage takes 
less than two minute’s. This is about the same amount of time it takes just to 
load the CAD package on my works CAD machine.
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With the corner fillets in place it's now time to define the inner and outer race.

The thickness of each race is 1.92mm, so we 
need to divide the cross section accordingly.

(You should now know the keyboard 
commands to select, extrude and constrain 
vertices to a set axis, so from now on I will 
only include the commands for these 
operations occasionally.)

Select the bottom left vertex and Extrude it on 
the Z-axis 1.92mm. Then extrude this vertex 
7mm in the Y axis.

Select the top left vertex and extrude it 
-1.92mm in the Z-axis. Then extrude this 7mm 
in the Y-axis.

The thickness of the Inner and outer race is now defined.

The next stage is to form the grooves that the 
ball bearings will run in. To do this we must spin 
a circle from the centre point of the two bearing 
races.

Hold Shift and Select RMB the four vertices that 
are on the ends of the two edges that we have 
just created to define the thickness of the inner 
and outer race.

Press Shift-S and snap the cursor to the 
selection. Because we have selected more than 
one vertex the cursor will snap to the centre of 
all the vertices.
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We now need to snap a vertex to the cursor. 
To insert a vertex, ensure nothing is 
selected A and holding the Ctrl key click 
LMB anywhere near the cursor. A new 
vertex will be created.

Snap the vertex to the cursor. Shift-S, 
Selection->Cursor.

The Ball Bearings have a diameter of 
3.95mm so we need to spin a radius of 
1.975mm.

Extrude the vertex -1,975 on the Y-axis.

In the Mesh Tools panel set Degr: to 360 as 
we are going to spin a complete circle. Set 
Step: to 64. This will give us a sufficiently 
detailed circle.

Its worth noting that if possible you should 
always choose a number of steps that will 
give a vertex on each of the circles 
quadrants.

With the vertex we have just extruded still 
selected spin the circle.

Excluding the vertices whose edges 
intersect the line defining the inner and outer 
race, the centre vertices are no longer 
required and can be deleted.

Rather than Shift-RMB selecting all the 
vertices Blender allows you to box select a 
group of vertices. To do this press the B key, 
the mouse pointer will change to a cross 
hair. Position it above and to the left of the 
vertices you need to delete. Press and hold 
the LMB and drag the cross hair to the lower 
right of the vertices to be deleted, release 
the LMB. The vertices within the selection 
box will now be selected.

Press X and Delete the vertices.
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Until now we have been working with the pivot set to Median. This means that 
if you rotate or scale a group of vertices the centre of the rotation or scale will 
be the centre of the selected vertices.

To align the end vertices of the bearing grooves we need to rotate individual 
vertices around the centre of the ball bearing.

On the view header click on the pivot button and choose 
3D Cursor. As the cursor is already positioned on the 
centre of the ball bearing we can rotate the end vertices.

Zoom in on one of the end vertices by rotating the 
SW (scroll wheel) and panning by pressing Shift 
and holding the MMB whilst moving the mouse. To 
rotate the vertex press R and drag the vertex until 
it is over the line defining the inner portion of the 
bearing race. Click the LMB to accept the rotation. 
Repeat this on all four vertices

The vertices we have just rotated will be close to 
the edge defining the inner surfaces of the 
bearing race but not exactly on it. To correct this 
we will position the cursor on the inner surface 
edge. Select a vertex on the edge and Shift-S 
Cursor->Selection.

Then scale the two vertices onto the edge. Press 
S to scale Z to constrain the movement to the Z-
axis and 0 to position the vertices in line with the 
cursor.

Repeat this on the other edge.
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We now have enough detail to complete the inner 
race. Select the 6 reference vertices shown 
above and X delete them

We are left with the two corner fillets and the 
bearing groove.

To reconstruct the face of the bearings inside 
diameter select the inner most vertices on the 
bottom fillets and press F to insert an edge.

Extrude the end vertex of the bearing groove 
and constrain to the Y-axis

To align this to the outer edge of the bearing 
snap the cursor to the top vertex of the fillet. 
Re-select the extruded vertex and scale S 
constrain to the Y-axis and 0 to set its 
position in line with the cursor.
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The inner edge of the inner race has a 0.05mm 
chamfer. To form this press G to grab the vertex 
(move), Y to constrain, 0.05 to set its position.
Now extrude this vertex -0.05 in the Y-axis then grab 
G, constrain Z, -0.05 to position. The chamfer is now 
formed.

Finally join the chamfer to the fillet with an 
edge. Select the end vertices on the chamfer 
and fillet and F to insert a new edge.

Repeat this on the other end to complete the 
section of the inner race.

The outer race is a little mode difficult as it 
contains a circlip groove and location for the 
dust shield.

The creation of this form is fairly 
straightforward. From the top left corner 
vertex simply extrude and constrain the 
movement to the Z and Y-axis at the 
dimensions opposite.

Once completed repeat this on the other 
end of the bearing.

Once the edges are in place you can refine the cross section by adding a 
0.02mm chamfer on each of the corners. This can be achieved by deleting 
one edge, extruding the end vertices 0.02 in the direction of the deleted edge, 
reinserting the edge and then moving the corner vertices 0.02 in the 
perpendicular axis.

Delete X the six vertices used as reference 
points.

Blender - Precision Modelling Guide 
By: Robert Burke www.rab3d.com - 25 -



The basic shape of the outer race is now 
constructed. Select the vertices both ends of 
a gap and press F to insert an edge. Do this 
one edge at a time until the outer race is 
complete.

The section through the bearing is now 
complete and we are ready to spin this 
through 360 degrees to form the 3D model. 
However the spin process rotates around the 
cursor and it is currently in the wrong 
position. When we started to construct the 
section we worked from the Object Centre 
which defined the centre axis of the bearing.

To snap the cursor to the object centre press 
Tab to go into Object Mode. From here you 
can press Shift-S Cursor->Selection The 
selection point of an object is the object 
centre.
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Tab back into Edit Mode and press A to select 
all vertices.

As we want to spin the bearing in the front view 
press NumPad 1 and the view will change with 
the vertices lined up above the cursor.

In the Mesh Tools panel check Degr: is set to 
360 and Step: is set to 64. Press spin. The 
bearings inner and outer race will be formed.

The last set of vertices created will now be 
selected but they aren't yet connected to the 
first set of vertices.
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To join these press A twice to select all the 
vertices then W to bring up the Specials menu, 
from this select Remove Doubles, which will 
merge any vertices that are sitting on top of 
each other.

That's it for modelling the inner and outer race. 
Press Tab to go into Object Mode and rotate the 
view with the MMB to see the 3D view of the 
bearing from any angle. You can pan the view 
with Shift-MMB and moving the mouse.
If you loose your model from the view you can 
retrieve it by pressing the Home key

You will notice however that all the faces are flat 
with faceted edges to correct this in the view we 
will smooth the surfaces we need to appear 
round and retain edges we need to be sharp.

Tab back into edit mode and select all A. In the Link and Materials panel click 
"Set Smooth".

If areas of black appear on the surface of the bearing press Ctrl-N and accept 
"Recalculate Normals Outside". This will allow Blender to know which side of 
the faces are pointing to the outside of the object and which are on the inside.

In the Modifiers panel press Add Modifier. 
From the pop up menu choose Edge Split. In 
the Edge Split modifier  "From Marked As 
Sharp" and "From Edge Angle" will already be 
selected.  Leave Split Angle:30. Which will 
smooth the join between any faces with an 
angle of 30 degrees or less. You will notice though that there is not a sharp 
edge between the bearing groove and the inner edges of the race because 
the angle is less than 30 degrees. This can be corrected by marking these 
edges for the Edge Split modifier to recognise as sharp.
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Select the edge loops on the outer edges of the 
bearing groove. This can be achieved by first 
deselecting all vertices A and then selecting each 
loop Shift-Alt-RMB

With the four loops selected press Ctrl-E to bring up the Edge 
Specials menu.

Select "Mark Sharp". This will tell the Edge Split modifier that 
these edges should be viewed as a sharp edge and it won't apply 
any smoothing to them.

Before we create the next object we will give this 
one a meaningful name. In the Links and Materials 
Panel Click in the OB: Plane field

Delete plane and re name the object 608-Race

This is a good point to save your work. Press Ctrl - 
W and accept the save menu.
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In Parts 1 and 2 we created the bearings 
inner and outer race, now we need to add 
some ball bearings. The 608 bearing has 7 
balls so we will create and position one 
ball and then use a similar spin process to 
position the other six. This time though we 
will use "Spin Dup" to duplicate the 
selected vertices of the first ball around the 
cursor at the required step positions.

In front view Num-Pad 1, go into edit 
mode Tab, select wire frame Z, and de-
select all vertices A.

Before we insert a Sphere to use as the ball bearing we need to position the 
cursor central to the bearing groves of the inner and outer race. To do this we 
will hide all the vertices of the bearing race other than the perpendicular 
section directly above the cursor.

Press B (Box Select) and drag a selection 
box to select all the vertices to the right of 
the vertical centre line. Press B again and 
select all the vertices to the left of the 
centre line. Repeat this again to select the 
remaining vertices below the horizontal 
centre line. If you select the wrong vertices 
simply press Ctrl-Z to undo the selection.

You should be left with only the vertices 
directly above the bearing centre 
deselected.

Press the H key to hide the selected 
vertices. The vertices haven't been deleted 
they are hidden so they don't clutter the 
view and cant be edited. You can retrieve 
these vertices at any time by pressing Alt-H.

You will now have one row of vertices directly above the bearing 
centre.
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Press NumPad 3 to go into side view and 
select RMB the centre vertex of the inner 
race, bearing groove. Now add to the 
selection Shift-RMB the vertex directly 
above this on the outer race. The centre of 
these two vertices is the centre point for the 
ball bearing.

Press Shift-S to bring up the snap menu 
and select Cursor->Selection. The cursor 
will be positioned at the insertion point for 
the first ball.

Un-hide the vertices we hid to make 
positioning the cursor easy by pressing Alt-
H. Change to front view NumPad 1 and Tab 
into Object Mode. You will see the cursor 
positioned between the bearing races 
directly above the Object Centre.

To form the ball we will use one of Blenders 
pre-set objects, the UV Sphere. The sphere 
is constructed from a series of latitudinal 
and longitudinal edges with poles at the top 
and bottom.

We will be using the geometry from the 
sphere to construct the bearing cage and it 
is important that it is oriented correctly. 
When we insert the sphere we need one of 
the poles to be pointing towards the bearing 
centre.
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To achieve this it is necessary to insert the sphere 
whilst in the top view, so press Num-Pad 7 for the 
top view and then press the Space Bar to open the 
Toolbox. select:  Add > Mesh > UVsphere.

Accept the default 32 segments and 32 rings, a UV 
sphere will be inserted centred on the cursor with a 
diameter of 2mm. The mode will have switched to 
Edit Mode and all the vertices will be selected. If you 
click into front view NumPad 1, You will see the 
bearing is hanging in space and too small for the 
race. To correct this we need to scale the bearing.

To obtain the correct scale factor, divide the 
required size of the ball by the inserted size of the 
UV sphere. As the balls are 3.95mm diameter and 
the UV sphere is 2mm then: 3.95 / 2 = 1.975.

Press S for scale 1.975 for the amount and Enter to 
accept. The ball now correctly fits the race.
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Blender 2.44 Update
When you add a UV sphere there is a new 
floating panel that allows you to specify the 
radius, along with the segments and rings of the 
sphere. So you no longer need to calculate the 
scale factor when imputing some of the mesh 
primitives.
You can now simply hold down Shift and Click LMB over the radius figure and input 
the new radius of 1.975 and click OK. The UVsphere will now be inserted at the 
correct size.

Its still good to understand how to calculate a scale factor, as it will be needed in 
many other modelling situations.



The Object Centre for the ball is currently central to 
the UV Sphere and it would be much more useful if 
it was positioned central to the Bearing. To achieve 
this Tab into Object mode and select RMB the 
bearing race. Press Shift-S to bring up the snap 
menu and select cursor->Selection. The cursor will 
be repositioned to the centre of the bearing. Now 
reselect RMB the Ball

In the Mesh Panel there are three options for 
moving the cursor.

Centre: moves the object so it is centred over the 
Object Centre.

Centre New: Moves the Object Centre to the 
centre of the object.

Centre Cursor: moves the Object Centre to the 
cursor position, which is the option we require.

With one ball in place we now need to create the other six. As the cursor is on 
the bearing centre we can duplicate the  first bearing 7 times around the race.

To achieve this Tab into Edit Mode.

In the Mesh Tools panel set the Deg: and Steps: 
as shown.

Press Spin Dup to duplicate the vertices seven 
times around the cursor. As with the spin 
command we have just placed a copy of the 
original ball over the top of the first one. To 
correct this select all vertices A, you will need to 
press it twice, once to de-select the last ball and 
then to select all. Press W (Specials Menu) and 
then select remove doubles.
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To change the appearance from the faceted 
surface of the UVsphere to a smooth surface, 
with all vertices selected click "Set Smooth" in 
the Links and Materials panel.

The balls are now created and positioned 
around the bearing. Press Tab to go into 
Object Mode, Z for solid view and rotate the 
view with the MMB to see the bearing as a 3D 
object.

In the Links and Materials panel rename OB:Sphere to OB:608-Balls

If you haven't already done so press Ctrl-W and save your work.

Part 4 modelling the cage becomes a little trickier but as you get used to 
panning, rotating and zooming the view, selection of vertices and constructing 
models becomes a little easier to achieve.   
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When we inserted the UVsphere that formed 
the ball bearings it was important to ensure 
that one of the poles pointed to the centre. By 
doing this it has left us with the rings of the 
ball running perpendicular to the to the 
bearing centre axis and this allows us to 
extract the geometry from the surface of the 
UVsphere to form the inner profile of the 
bearing cage. This will become as little clearer 
as we work through this part of the tutorial.

In front view select the balls, as the bearing 
race will get in the way of our view select local 
view NumPad /. This will remove everything 
from view except the selected objects.

With only the balls in view, zoom in and pan on 
to the top ball, SW (scroll wheel) to zoom, 
Shift MMB to pan.

Tab into Edit Mode and go into solid view Z.

On the view header select the Limit selection to visible 
button, so you only select vertices from one side of the 
sphere. Without this being checked you would also 
select the unseen vertices from the back of the sphere.

Box select B 8 rings of vertices starting from 
the centre ring and moving towards the bottom 
of the sphere. We will copy these vertices and 
turn them into a new object, they will then form 
the inner part of the bearing cage.
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Press Shift-D to copy the vertices, then press 
Esc so they aren't moved from their original 
position. A new set of vertices has been created 
on top of the sphere. With these still selected 
press P (part) to separate them from the 608-
Balls object. A new object has now been 
created and removed from the current Edit 
Mode selection.

Tab into Object mode and though not visible the 
new cage object is on top of the top UVsphere. 
RMB click over the cage and its outline will be 
highlighted. Tab back into Edit Mode.

Currently the vertices of the cage are sitting on 
the surface of the ball which would stop the 
bearing from turning, so we need to add some 
clearance. To achieve this we will scale the 
cage from the centre of the top ball bearing.

First we need to set the cursor at the centre of 
the top ball. Tab into Object Mode and select 
the 608-Balls Object. Tab into Edit Mode and 
de-select all A move the mouse close to a 
vertex on the top ball and press L (link select) 
this will select all the vertices directly linked by 
an edge to the vertex you are closest to. All the vertices of the top ball will 
now be selected. Shift-S and snap Cursor->Selection, this will centre the 
cursor on the top ball.

Tab back into Object Mode and select the Cage and Tab back into Edit mode. 
Make sure the Pivot Point is set to 3D Cursor and scale S the cage 1.02 This 
will give you a clearance of 0.0395 between the ball and the cage. ((Diameter 
* 1.02) - Diameter) / 2
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We have now got the inside profile of the cage 
but we need to add thickness to it. We could 
simply Extrude a new set of vertices and then 
scale them from the centre however we would 
need to work out a scale factor. Instead Blender 
has the ability to scale all faces in the direction 
of the face normals (see Blender Wiki for 
explanation of Normals). As we are scaling 
individual vertices then we only need to use the 
thickness as the scale factor.

With all the vertices selected extrude E select “Region” from the sub menu 
and then press Esc so the new vertices don't change position. Press Alt-S to 
scale along normals and -0.3 for the thickness then press Enter. The cage is 
now 0.3mm thick

As we have created the thickness of the cage 
by scaling in the direction of the faces, the new 
end vertices are no longer on the centreline of 
the bearing. With the cursor still on the centre of 
the top ball and Pivot set to 3D cursor, select 
the new end vertices (you will need to deselect 
the "Limit selection to visible" button or go into 
wire view Z) Shift-RMB and scale S in the Y 
axis to 0.

It may be easier to select all the end vertices of 
the cage as those that are already on the 
centreline won't move. Box Select vertices 
within the area outlined above then with pivot in 
3D Cursor, Scale Y-axis to 0)

We now have the cage form that surrounds the 
bearing but if we Spin Dup this we will still be 
missing the section that bridges between this 
ball surrounds. Therefore before we Spin Dup 
this section we need to locate vertices so the 
bridging section when formed is 0.3mm thick.

In top view select the outer most vertex and extrude 
it -0.3 in the Y axis. This vertex will be the reference 
point to cut a new row of vertices.

Select all A and press K (knife) a sub menu will open 
select Knife (Exact). The mouse icon will change to a 
knife. Move the knife close to the reference vertex 
and holding down Ctrl click with the LMB the cut line 
will be snapped to the reference Vertex.
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Drag the line to the right and click MMB this will 
constrain the cut to a line running horizontally 
along the view, which is the X-axis. With the line 
passing all the edges of the left side of the cage 
click LMB to set the line and then Enter to cut 
new vertices.

Repeat the cut on the other end of the cage, then delete X the 
reference vertex.

We now have a row of vertices running 
parallel with the back face of the cage at 
0.3mm. We will need to delete the faces and 
edges between this new row and the back 
edge. To make selection easier go into Edge 
Select.

Select Shift-RMB over the 6 edges indicated and delete X 
selecting Edges from the delete menu. Repeat this on the other 
end.

The cage profile should now have a row of faces missing on either 
end. When extruded and joined to the next cage profile, this will 
allow us to have a continuous shell without any faces or edges 
inside the model.

As the cage has been created from the 608-Balls Object, 
its object centre is on the bearings centre axis. Tab into 
Object Mode and snap Shift-S the cursor->Selection to 
centre the cursor on the bearing axis. Tab back into Edit 
Mode and select all vertices A.

In the Mesh Tools panel set Degr: 360 and Step:7 and 
Spin Dup the vertices. Select all vertices A and remove 
doubles W
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Click back into vertex select mode.

We now have 7 cage profiles that need to be joined together. 
Zoom in on the top profile and select the loop of vertices 
around one of the open ends Alt-RMB

In front view, extrude the selection E and accept Only 
Edges from the sub menu. Drag the extruded 
vertices towards the next cage profile.

We now need to merge the extruded vertices onto 
the next cage profile.

To do this select one vertex on the extruded edge 
(1) then Shift select the corresponding vertex on 
the next cage profile (2). Press Alt-M to open the 
Merge sub menu and select "At Last". This will join 
the vertices at the position of the last selected 
vertex.

Repeat this for all the vertices around the loops to 
be joined.
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We now have two cage shells joined together 
with a connecting bridge all with a thickness of 
0.3mm.

Soon we will mirror this cage to form the cage on 
the other side. But before this a little more 
geometry is needed, as the two half cages are 
joined together with a folded tab over the outer 
circumference of the cage.

To create the vertices that will eventually form the 
joining tab, select all A and cut through the 
bridging section K but this time accept Knife 
(Multicut) from the Cut Menu. A new sub menu 
will open allowing you to choose the number of 
cuts. Accept the default 2.

Two new edge loops will be formed on the bridging 
section, but not in the position we require them in.

To reposition the vertices we will use Edge Slide to slide the loops 
of vertices towards the cage sphere profiles. Alt-RMB select one 
loop and turn on "Edge Length" in the Mesh Tools 1 panel.

Press Ctrl-E to open the Edge 
Specials menu and choose "Edge 
Slide". Slide the loop of vertices until 
the top vertices are 0.3mm from the 
cage sphere profile as shown above. 
Whilst moving the loop you can press 
Shift to give finer control of the 
movement.
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With the two edge loops slid to a position 0.3mm 
from the cage spheres select the vertices of the 
bridge section. (The two edge slide loops and the 
two loops connecting the bridge to the sphere.

Ensure the cursor is still on the bearing centre 
axis and Spin Dup the selected vertices. Degr: 
360, Step:7.

Select all and remove doubles. 

You have now made the basic construction for 
one half of the cage. We will chamfer the edges of 
this but first we need to copy and mirror this object 
to make the other half of the cage.

In the Links and Materials panel change the 
Objects name from OB:608-Balls.001 to OB:608-
CageA, the previous name was automatically 
assigned by Blender as copy 001 of the 608-Balls 
object, from which we copied the cage geometry.

If you have not been doing so at frequent intervals 
press Ctrl-W and save your work.

In Object Mode go to the side view NumPad-3 and copy the cage Shift-D 
then press Esc so the position of the copy does not move.

We now need to Mirror this copy on the Y-axis. Ensure the cursor is on the 
Object Centre (centre of the bearing) and press Ctrl-M (Mirror)

This will bring up the Mirror Axis sub menu choose "Y 
Local".

The copy will flip over to be a mirror image of OB:608-
CageA with the name OB:608-CageA.001.
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In the Links and Materials panel rename this object OB:608-
CageB.

Our model now consists of four objects. To make selection easier 
blender has the ability to show an object layout in the form of a 
tree structure. This is seen in the Outliner window.

To enable this we first need to make room on our 
screen for a new window. Move the mouse over the 
join between the 3D view and Buttons Windows. The 
mouse pointer will change to a double arrow

RMB click  whilst the arrows 
are showing and a sub-menu 
will appear, LMB click on 
Split Area. A split line will 
follow the mouse pointer. 
Move the mouse over the 3D 
view.

LMB click and a new 3D view will be created.
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Click on the Window type button in the lower left corner of 
the new window, a Window type menu will appear choose 
Outliner.

The view will now show a list of all the objects that are in 
our scene (assembly and 3D space). Together with the 
default Lamp and Camera.

It may be necessary to increase the width of the Outliner 
window to see all the  options. To do this move the mouse 
pointer over the join between the 3D view and Outliner, the 
pointer will change to a double arrow. Hold down the LMB 
and drag, the size of windows will change according to the 
mouse position.

By clicking on the objects name in the Outliner, the 
object will become selected in the 3D view.

Clicking on the eye symbol will show or hide the 
object in the 3D view.

Clicking on the arrow will lock the object so it 
cant be accidentally edited.

The square camera icon stops the object being 
rendered to a bitmap image but still allows you 

to see it in the scene.

Now we have both sides to the bearing 
cage however there is still one operation 
that needs to be performed on OB:608-
CageA. No mechanical parts have a 
perfectly square edge especially pressed 
parts like the bearing cage. So we need 
to add a chamfer to the outer edges of 
the object.

This process is greatly simplified by using one of the python scripts, so we 
need to open a scripts window. As above with the Outliner, split the 3D view 
but this time on the right hand side of the view. From the window type menu 
choose scripts window. In the scripts window LMB click on Scripts go to mesh 
and choose Bevel Centre. This will be used to add a chamfer to the chosen 
edges.
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In the outliner window click on 608-
CageA to select it and then click on the 
eye icon for the other objects to remove 
them from view.

Your screen will become quite cluttered 
and with the need to open more and 
larger windows the 3D view will become 
uncomfortably small, especially if you 
are using a small monitor. To make 
selecting and modeling easier you can 
force any of the windows to full screen by pressing Ctrl-Down Arrow with the 
mouse pointer over the window, giving a much better work area, pressing 
Ctrl-Down Arrow again will return the screen to the normal layout.

In Edit Mode zoom in on one of the cage spheres and set the 
selection to Edge Select.

It’s now a matter of selecting all the edges on the 
outer and inner circumference.

Shift-Alt-RMB select the edges indicated and 
work your way all around the circumference of 
the cage. Check you have four continuous loops 
selected. This check may be easier in wire mode 
Z.

In the Bevel Centre Shift-LMB over the thickness 
figure and change it to 0.05. This will give a 
0.05mm chamfer.

Press Bevel and after a few seconds a chamfer will be 
created on the selected edges.
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To get a smooth appearance on our cage 
we will add an Edge Split modifier. In 
vertex Select, select all vertices A and in 
the Mesh Tools panel press Set Smooth.

In the Modifiers panel press Add Modifier, 
From the pop up menu choose Edge 
Split. In the Edge Split modifier  "From 
Marked As Sharp" and "From Edge 
Angle" will already be selected.  Leave 
Split Angle:30. Which will smooth the join 
between any faces with an angle of 30 
degrees or less.

If black patches appear on the surface this is 
because the computer doesn't know what side of the 
face is outside. To correct this press Ctrl-N and 
recalculate normals outside.

OB:608-CageA is now complete.

Press Ctrl-W and save your work.

In part 5 we will add the clasp that joins the two half 
cages to OB:608-CageB.
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With 608-CageA now complete its time to go 
back to Cage B which we copied and mirrored 
from cage A before the chamfers were added.

In the Outliner click on 608-CageB, select the 
Eye icon to bring it into view and close the eye 
icon of 608-CageA.

When we originally mirrored the cage from 608-CageA, we effectively applied 
a scale factor of -1 in the Y axis. Press N to open the Transform  Properties 
window, You will see ScaleX:-1.000. To clear this back to ScaleX:1.000 we 
need to apply the scale to the object. To do this press Ctrl-A and accept 
"Apply Scale and Rotation". If you had simply changed the number in the 
Transform Properties window to 1 the cage would have flipped back to the 
other side of the bearing

In front view select the vertices that make 
up the loops we cut in the bridging section 
between the ball cups. Shift-Alt-RMB but 
leave the vertices of the bottom bridging 
section deselected as these are parallel to 
the X axis and the easiest to modify.

With the vertex loops selected on all but the 
bottom section, press X to delete them

Zoom SW, pan Shift-MMB and rotate the 
view MMB, until you obtain a good viewing 
angle on the bottom face of the remaining 
bridging section. Select the central bottom 
face. (Shift-RMB the 4 vertices on the 
corner of the face.)

Switch to top view and go into wire view 
mode Z. you will see the selected edges are 
not square because they were cut from 
geometry originally created from the ball 
bearing's UVspheer, so we need to square 
up the edges.
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Select the face vertex on the outer surface of the 
cage and Shift-S snap Cursor/>Selection. Select 
the vertex on the opposite end of the edge and 
Scale S constrain X to a scale point of 0. Repeat 
this on the other edge of the face.

Select one of the edges that cross the 
bottom face. Go to side view and wire view 
mode. You will see that the edge is not 
aligned to the Y-axis, this is because of the 
same reasons the edge above are not 
square. 

Extrude E (Only Edges from sub menu) a 
face from this edge constrained in the Z-
axis. The length of the face is not important. 
We will use this face to see what angle the 
edge is at.

In the mesh tools 1 panel select edge angle and then 
select the four vertices of the face. The angle of each 
face corner will be displayed.

To form the clasp we need to spin the bottom face 
92.376 degrees. Select only the bottom two vertices and 
delete them X as they were there just to obtain the 
required spin angle.

Select one vertex on the inside edge of the bottom 
face and snap Shift-S Cursor->Selection to position 
the cursor to the centre of the spin radius.

Shift-RMB Select the other vertices of the bottom 
face.

Go to side view NumPad-3.

In the Mesh Tools panel set Degr:92.376 and Step:7 
and press Spin. Select all A and remove doubles W as 
we have also stacked 7 vertices on either end of the 
edge below the cursor.
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Re-select the newly spun face and Extrude E (Region 
from sub menu) and 0.3 for the distance. When you 
select region a new face will be extruded constrained 
to an axis perpendicular to the original face.

If the face extrudes in the wrong direction press grab 
G constrain to Y and distance -0.6 (-0.3 to bring it 
back to the cursor and -0.3 for the correct position)

Select one vertex on the 
top edge of the new face 
and snap the Cursor to the 
vertex. This sets the centre 
for the next spin. Then 
select the remaining 
vertices of the face.

In the Mesh Tools panel set Degr:90 and leave Step:7. Go 
to side view and press Spin. The next section of the clasp 
will be formed.

Select all A and remove doubles W to remove the vertices 
stacked under the cursor.

Reselect the newly created face 
and extrude (Region) 0.2mm

With the vertices of the face still 
selected cut a new edge across 
the centre of the face. K Knife 
(Midpoints). Two new vertices 
will be created.

Select the two new vertices and delete X (Edges). The edge 
joining the two vertices and both faces either side will be 
deleted.

Select one middle vertex and snap the cursor to it.
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Select the two centre vertices and the two on the left 
edge. We will spin these in front view to form the 
front radius of the clasp.

In the Mesh Tools panel set Degr:180 and Spin:14, 
go to front view and then press Spin. As before 
select all and remove doubles.

Select the newly formed clasp and the four edge 
loops that make up the bridging section.

We are now going to Spin Dup the new bridging 
section with the clasp around the cage.

Tab into Object Mode and snap the cursor to the 
object centre.

Tab back into Edit Mode.

In the Mesh Tools panel set Degr:360 and Spin:7.

Press Spin Dup to copy the bridging section between 
the cage spheres.

Select all and remove doubles.
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Its now time to add the fillet around the 
edges of the cage. This time the outer edge 
loops will also follow around the clasp.

Follow the details in Part 4 to add the Fillets 
but with Edge Select activated make sure 
you select continuous loops that also 
include the clasp.

Add the 0.05mm Fillets with the bevel 
Centre script.

Add the Edge Split Modifier also detailed in 
Part 4

This completes OB:608-CageB

Press Ctrl-W and save your work.

In the next section's we will add the dust shield and 
circlip to complete the detailed model of the 608 
bearing
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The dust shield will be formed in the same way as we made the 
bearing inner and outer race. We will create a section through the 
dust shield and spin this around the bearing centre to form the 3D 
component.

In the Outliner set the 608-Race to visible and hide all the other 
parts. In Object Mode snap the cursor to the 608-Race object to set 
the cursor in the centre of the bearing.

We will start this object with a plane, so press the Space Bar to 
open the Tools menu and Add>Mesh>Plane. The plane opens in 
Edit Mode.

Drag the four vertices of the plane and position them in the 
retaining grove of the outer race.

Select the bottom two vertices and delete them X as we will 
start the dust shield using only the top two vertices. 

Grab G the end vertex and move it along 
the Y-axis 1.75mm so the top edge 
measures 0.25mm, the thickness of the 
dust shield.

Extrude E (Only Vertices) the two end 
vertices in the Z axis -0.75.

Grab G the inside bottom vertex and move 
it in the Z axis a further -0.144mm to form 
an angle between the two vertices of 60 
degrees from the vertical. 

Set the cursor on the inside lower vertex and then 
extrude this -1.5mm in the Y axis.

Rotate R this edge -30 degrees from the cursor. 

Repeat this for the outer edge. 
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The dust shield offsets 0.85mm so 
extrude two reference vertices from 
the top corner. -0.6 then -0.25 in the 
Y axis

Extrude a face from these vertices constrained to the Z-axis 
and position the new vertices between the dust shield edges. 
Extrude another face along the Z-axis below the dust shield. 

We will use the reference edges to accurately cut the angled 
dust shield edges to length.

Select all vertices A and open the knife menu K, select Knife 
(Exact)

Click LMB below the lower right reference vertex,  press Ctrl 
and move the knife towards the bottom left vertex the cut line 
will snap to the vertex click LMB to set the line then move to 
the vertex above Ctrl-LMB this vertex to snap the cut line, 
then press Enter to accept the cut. 

Repeat this on the outer edge but start the cut line on the top 
left vertex and cut to the vertex below.

We now have two new vertices setting the offset width of the 
dust shield. 

We no longer need the reference vertices or the end vertices 
of the dust shield edges.

Select these vertices and delete them X
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Select the two end vertices of the dust shield ready to 
extrude them. 

Before we extrude them we need to set the cursor on the top 
of the inner bearing race. Tab into Object mode and select 
608-Race. Tab back into Edit Mode for this object. Select a 
vertex from the top of the inner race RMB and snap the 
cursor to this, Shift-S Cursor->Selection.

Tab back into Object Mode, select the Plane object (dust 
shield) and Tab back into Edit Mode for this object. 

Extrude the two selected vertices towards the inner race 
constrained in the Z-axis. 

We will now scale them onto the inner race. 

With the pivot point still set to 3D cursor press S for scale Z to 
constrain the movement to the Z-axis and 0 to scale the lines level 
to the cursor.

The vertices are now touching the inner race so we need to back 
them off a little to provide some clearance. 

Move the vertices G (grab) Z constrain 0.02 for the 
clearance. The vertices will now be clear of the inner race.

To complete the basic shape of the dust shield press F to 
put an edge between the vertices. 

We now have the basic cross section of the dust shield positioned 
accurately against the bearing race. As we no longer need to reference 
the bearing race press Num-/ to go into local view for the dust shield.

The last thing to do to the cross section is add some fillet radii to the 
offset corners.
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Adding Fillets

I will show two methods of accurately positioning the fillets, one using 
trigonometry and one using reference geometry that has no need for a 
calculator. For both methods you will need to know the angle between the 
edges, the fillet radius and have one edge aligned to a known axis.

Fillets - Trigonometry Method 

First we need to know the angle between the edges we are going 
to fillet. If you haven't been planning the construction of your model 
and placing lines arbitrarily you can find the angle by forming a 
face from the three vertices and using the edge angle button in the 
Mesh Tools 1 panel.

Another requirement is for one of the edges to align with a known 
axis. 

To work out the centre point of the fillet we simply 
construct a right angle triangle with half angle A and 
the radius. The hypotenuse is the distance to the 
centre point at an angle of half A 

Therefore:  Sin 1/2A = Radius/ Hypotenuse

 Hypotenuse = Radius/ (Sin (A /2))

Once you have determined the hypotenuse simply extrude E this from the 
intersect along the known axis and rotate R it 1/2 angle A 

Fillets - Reference Geometry Method

Extrude a vertex from the intersect 1.5 
times the radius. 

Rotate this vertex 1/2 angle A 
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From the intersect extrude a vertex perpendicular to the 
edge on the known axis and the length of the fillet radius. 

Extrude another vertices from this parallel to the edge on the 
known axis.

Where these two lines cross is the centre point for the fillet. 

Using the knife tool K snap a cut line Ctrl-LMB between the 
two reference vertices parallel to the known axis line and cut 
a new vertex on the centre point of the fillet. 

From the centre point extrude a vertex perpendicular to the 
edge on the known axis at the length of the fillet radius. 

Set the cursor on the centre point and spin the vertex on the 
end of the radius edge through an angle of

180° - Angle A 

Delete the reference vertices. 

Re make the edges between the fillet 
and surrounding vertices. 
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Getting back to the dust shield we will use the reference geometry method to 
position the fillets with a small radius of 0.1mm and a large radius of 0.35mm. 
The angle between the edges is 120 degrees. 

From the intersect on the inside of the angle 
extrude E a vertex along the Z axis 0.15mm, 
then rotate R the vertex -60 degrees. 

Again from the intersect extrude a vertex -0.1 in the Y axis 
(distance of radius) and then extrude this above the 60 degree 
edge. 

Select all A and then K Knife (Exact) a vertex 
on the 60 degree angled line snapping the cut

Ctrl-LMB to the edge set at the radius distance 
from the dust shield.

Select the new vertex which has been created 
on the fillet centre and snap the cursor to it. 

From the fillet centre extrude a vertex 0.1 on the Y axis for the front 
fillet then extrude this 0.25 on the Y axis for the back fillet.

In the Mesh Tools panel set Degr:60 and Step:7 and spin the two 
vertices. 

In edge select mode press B twice to bring up the selection painter 
reduce the size of the selection circle MW and select LMB the 
edges between the fillets. Delete X these edges.

Repeat this procedure to produce the bottom fillet. 
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Back in Vertex Select mode, select the reference 
vertices along with those on the original angle 
intersects and delete them. We are now left with the 
fillet's and top and bottom edges of the dust shield. 

Select a vertex either end of a 
missing edge and press F to insert 
a new edge.

Repeat this for all the open 
sections. 

We are now left with a completed cross section through the dust 
shield ready to spin into the 3D object, however as before the cursor 
is in the wrong position.

Select all A the vertices and Tab into Object Mode. 

Snap the cursor onto the object centre. Shift-S Cursor->Selection.

Tab back into Edit Mode and go to front view NumPad-1.

In the Mesh Tools panel set Degr:360 and Step:64 press spin to 
form the 3D object.

Select all vertices A and remove 
Doubles W. 

Blender - Precision Modelling Guide 
By: Robert Burke www.rab3d.com - 57 -



The dust shield is now almost complete, but chamfers are 
required on the corners.

In edge select mode loop select the four edge loops indicated 
Shift-Alt-RMB 

Using the Bevel Centre script detailed in  Part-4, add a 
0.05mm chamfer.

Finish the dust shield by adding an Edge Split modifier also 
detailed in Part-4.

A Dust shield will also be required on the other side of the 
bearing. Rather than repeating the modelling process we will 
duplicate this dust shield and Mirror it across the bearing 
centre.

Tab into Object Mode and go to the side view NumPad-3. 
Check the cursor is still on the object centre. 

Press Shift-D to duplicate the object then Esc to leave the 
duplicate on top of the original. 

Press Ctrl-M to open the Mirror sub menu and select "X Local". 

Both Dust shields have now been created so it is time to give them a 
meaningful name. Select Plane in the outliner and then in the Links and 
Materials panel change its name to OB:608-ShieldA. Repeat this for 
Plane.001 naming it OB:608-ShieldB.

Press Ctrl-W and save your work.

The final components for the bearing assembly are the circlips that retain the 
dust shields in place. These are covered in the next section. 
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The circlip is possibly the easiest of the parts to model. We will start by 
inserting a Plane object to form the circlip. 

Whilst in Object Mode go to the side view NumPad-3 and with the 
cursor on the bearing centre insert a Plane (Space to open the 
Toolbox then Add>Mesh>Plane).

Move the vertices so the top right vertex 
is positioned in the circlip groove of the 
outer race.

Select the left vertices, grab G and move them 1.6 in 
the Y axis so the width becomes 0.4mm. 

Select the bottom vertices grab and move them 1.25 in 
the Z axis so the hight becomes 0.75. 

Go into front view NumPad-1 and spin the vertices 
around the bearing centre. In the Mesh Tools panel Set 
Degr:360 Step:64.

Press spin to form the 3D ring. 

Select two loops of vertices through the ring and X 
delete them to form the opening in the circlip.

Make sure you have selected the vertices on the back 
edge as well as those on the front. 

Blender - Precision Modelling Guide 
By: Robert Burke www.rab3d.com - 59 -

608 Bearing Part-7 Modelling the Circlip



To allow the circlip to be prised out with a sharp tool the 
cut through the circlip is made at an angle.

To form this select the four vertices on the outer edge of 
the break and rotate R them from the centre of the circlip. 

Rotate your view and select the 4 vertices on one of the open 
ends.

Press F to insert a face.

Do the same on the other open end. 

Go into edge select mode and loop select the four 
edge loops forming the inner and outer edge Shift-
Alt-RMB.

Select all the edges of the ends.

Using the bevel centre script detailed in part 4 add a 
0.05mm fillet. 

Select all the vertices A and in the Mesh Tools panel 
press "Set Smooth". 

Finish the circlip by adding an Edge Split modifier with the 
default settings as detailed in part 4 

To finish off we will mirror this circlip onto the other side of the 
bearing.

In object Mode go into side view.

Copy the circlip Shift-D then Esc to leave it in the same position. 

With the cursor still on the object centre Ctrl-M for mirror and 
select "X Local". The copied circlip will be mirrored onto the other 
side of the bearing.
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In the outliner select Plane and then in the Links 
and Materials panel re name it OB:608-CirclipA. 
Select Plane.001 and rename it OB:608-CirclipB 

That completes the modelling of the components 
for the detailed bearing. In the Outliner open the 
eye icon for all the parts to bring them into view. 
(If the components don't appear you may still be 
in local view, try pressing NumPad-/ to close 
local view) Rotate the view to see your work.

The Dust Shields cover most of the components 
so you may want to hide one of the dust shields 
(Outliner eye icon).

Press Ctrl-W and save your work. 

To recap: the commands and tools you have covered in this tutorial include.

Short Cut
7 Top E Extrude
1 Front G Move (grab)
3 Right Side S Scale

SW Zoom In/Out (mouse Scroll Wheel) Shift-S Snap
MMB Rotate View (Middle Mouse Button) X - Y - Z Constrain to Axes

Shift MMB Pan View Tab Object/Edit Mode
Home Centre View Space Toolbox

Z Wire/Solid View Ctrl-Z Undo
LMB Set Point (Left Mouse Button) Edge Split Surface (Modifier)
RMB Select Spin Spin vertices around axis

Shift-RMB Select Multiple Vertices Spin Dup Copy Vertices around axis
B Box Select Edge Split Modifier
R Rotate W Remove doubles (Specials menu)
K Knife Ctrl-N Recalculate Normals Outside

Ctrl-E Mark Sharp (Edge Specials menu) Alt-RMB Loop Select
B-B Paint Selection Shift-Alt-RMB Multiple Loop Select

Ctrl-M Mirror Ctrl-D Duplicate (copy)
Alt-S Scale along normals

The completed bearing is ideal for producing visualizations or detailed 
drawings but with over 26,000 vertices it will require a lot of you computers 
resources if you have many of these in an assembly. 

My CNC machines assembly model will require 60 bearings and at this level 
of detail that gives over 1.5 million vertices far more than my old PC can 
handle, so Part 8 will show how to retain the precision of the design but with 
substantially fewer vertices.
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With the detailed model now complete its time to concentrate on the low 
vertices model that will have far less overhead on the computers resources 
when modelling large assemblies. We could start modelling from scratch 
repeating Part 1 but with fewer vertices on the fillets, however its a simple 
process to import (Append) the already created components into a new file 
and modify them. Open a new file and delete X the default cube. 

Turn off the transform manipulator (hand icon) 

Click File in the top left hand corner and select "Append or Link"

Navigate to the 608-
Bearing.blend and from the 
options choose "Object". The 
components will now be listed. 
RMB on the components 
highlighted. 

The five components will now be loaded in your file. If 
they are not visible open the Outliner and make sure 
the eye icon is open.

We need to join these components to make a single 
object. 

In the outliner select the five components and then 
with the mouse cursor over the 3D window press 
Ctrl-J. The components will be joined into a single 
mesh.

Tab into Edit Mode and press A to select all the 
vertices.

We only need a single cross section of vertices 
above the centre of the bearing. This cross section 
will be modified to reduce the number of vertices 
and then spun around the centre to form the 
bearing. 
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In front view press B twice to bring up paint select, 
reduce the size of the selection circle with the SW and 
pressing the MMB paint over the vertices directly above 
the centre. 

The vertices will become deselected. Press X and 
delete all the remaining selected vertices. 

Were now left with a cross section through the bearing 
but still with far to many vertices and a lot of 
unnecessary internal detail.

We will start stripping out the detail by remaking the 
corner fillets with a smaller Step: value. 

Select the lowest vertex on the top left corner fillet and extrude it 0.6mm 
on the Y-axis. This will give us the fillet centre point. 

Snap Ctrl-S, Cursor->Selection onto the fillet 
centre. select the existing internal fillet vertices 
and delete them.

Select the original lowest fillet vertex and in the 
Mesh Tools panel set Degr:90 and Step:4.

Press Spin to create the fillet, this time with three 
fewer vertices. Delete X the vertex on the fillet 
centre. 

Repeat this on the bottom left fillet. 
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We now need to create a continuous external profile of the 
bearing, combining all the outer vertices of the loose parts.

Cut two new vertices through the left circlip snapping the line 
to the edge of the circlip groove's chamfer. 

K Knife Exact, snap the cut line Ctrl-LMB to the circlip 
groove chamfer's. 

Add an edge between the groove and the circlip F. 

Repeat this and cut a new vertex on the dust shield with the 
snap line cut from the lower right chamfer of the circlip 

The offset fillet's of the dust shield still have more vertices than are 
needed.

From the top vertex of the top fillet extrude an edge -0.1 in the Y 
axis.

Snap the cursor to this new vertex which is on the fillet centre. 

Select the internal vertices of the fillet and delete them. 

Select the top vertex from the original fillet and spin this to form 
the new fillet.

In the Mesh Tools panel set Degr:60 Step:4 and press Spin.
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A new fillet has been created with three fewer vertices. 

Move to the lower dust shield fillet and repeat the 
above process.

This time extrude the bottom vertex of the inner fillet 
0.1mm on the Y axis to set the centre point. Snap the 
cursor to this. 

Select the inner vertices of the large outer fillet and 
delete them. 

Select the bottom outer vertex of 
the original fillet and spin this 
Degr:60 Step:4

The vertices of the lower dust 
shield fillet have been reduced. 
Delete the fillet centre vertex. 

Cut a new vertex on the inner race from the dust shield 
bottom fillet. K Knife Exact, Ctrl-LMB to snap the cut to 
the chamfer, MMB to constrain to the vertical  

We now have a continuous outer edge of vertices 
down the left hand side of the cross section, 
rather than repeating this on the right hand side 
we can delete all the other vertices and mirror this 
line of vertices onto the right hand side.

Box select B all the vertices on the right hand side 
of the cross section including the bearing groves. 
Delete these X. 
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Paint Select B-B the remaining inner vertices and delete these.

Tab into Object Mode and snap the cursor to the 
object centre. Shift-s Cursor->Selection. 

The cursor is now set on the bearing centre so we can 
mirror the left hand profile onto the right hand side of 
the bearing.

With the pivot point set to "3D Cursor" Tab into Edit 
Mode and select all vertices A.

Duplicate (copy) the vertices Shift-D then Esc to 
leave the copy over the top of the original.

Press Ctrl-M to open the Mirror menu and choose "X 
Local". The copy will now be mirrored to the other side 
of the bearing. 

Re-make the top and bottom edge by selecting a 
vertex either side of the opening and pressing F.

Select all A and remove doubles W to merge any 
doubled up vertices.
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Go into front view NumPad 1.

In the Mesh Tools panel set Degr:360 and 
Step:32. Press Spin to form the 3D Bearing.

Select all A, remove doubles W and in the Link 
and Materials panel "Set Smooth".

As the bearing was created from the original 
components, an Edge Split modifier will still be 
activated on this object. 

In the Link and Materials panel rename the 
object OB:608-BearingSmall.

Save the .blend file as 608-BearingSmall.

This version of the bearing has 2240 vertices, 
far fewer than the 26,000+ vertices of the 
detailed bearing. With 60 of these bearings in 
the CNC assembly it will still only require the 
computer overheads for 134400 vertices.

This completes the modelling of both versions 
of the bearing. In the next part we will look at 
adding basic materials to the bearing and 
rendering a 3D view and an exploded view of 
the bearing. 
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At the introduction to this tutorial I said I would not cover materials, textures or 
many of the other vast array of features available within Blender. However to 
use your model for visualisation or design drawing purposes you do need to 
know a little about the process of applying materials and rendering images to 
2D bitmaps. 

We will use the detailed model for this section so open the 
608-Bearing.blend file. When Blender opens it automatically 
inserts a Camera and Lamp object into your scene (3D 
workspace), in the Outliner select the Camera object

In top view move the camera G and position it to the 
front and right of the bearing. 

Rotate it R to point at the Bearing, also check it points 
at the bearing in side view. 

In the Editing Buttons
window the Camera panel gives options for 
the camera.

The default lens is 35mm, to wide an angle 
for a decent image so change this to 55mm 
which will give a less distorted view. For a 
full description of the camera controls see 
the Blender Wiki.

With the mouse pointer over the 3D window press 
NumPad 0 which will open the camera view. Select 
the outer rectangle of the camera RMB and move it G 
so it is centred on the bearing. If the bearing doesn't 
fit in the camera view signified by the dotted rectangle 
truck the camera along its view axis G-MMB and 
moving the mouse. 

When the bearing is positioned in the 
camera’s view select the bearing, then select 
the Shading button and the materials sub 
context button. 
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This will open the Links and Pipeline panel, click on 
add new to open a new material.

A range of material panels 
will become available to 
you. 

In the Material tab change the R, G, B sliders to .560 
to give a darker grey. 

Click the texture sub context and in the 
Texture panel click “Add New”. Select "Image" 
from the pop-up list 

n the Image panel load the shinyball_ref.jpg image.

This can be downloaded from the Blender Texture Disk. 
A link to the Texture Disk is available on the Blender 
Web Site, on the resources page. 

Go back into the material sub context buttons and in the 
“Map Input” tab and click Refl which will make the image 
affect the reflection vectors (See Blender Wiki). 

In the “Map To” tab leave the default settings. 
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Currently the 3D space has a dark 
blue background and we need to change this to white. 
In the World sub context, World panel change HoR, 
HoG and HoB to 1.00.

In top view NumPad 7 select the Lamp RMB and move 
G it to the left of the camera. 

Copy the Lamp Shift-D and move the copy to the right 
of the camera.

In front view, select both lamps Shift-RMB and move 
them G above the bearing. 

Lamp Buttons 

The Lamp panel gives the settings for Energy, 
distance, colour etc.

The default settings should be OK for this render. 

In the context buttons, click on the scene and sub 
context Render button. 

In the Format Panel change the Size x and Size Y to 
800 pixels and change the image format from Jpeg to 
PNG. 

In the Render panel de-select "Ray", as we don't need 
to use Ray Tracing.

Set "OSA" to 16, so we get a good smooth edge to the 
render.

Press the Render button, a new window will open and 
an image of the bearing will be created. 
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To save the image go to File>Save Image or Press F3. The active window will 
change to a file window allowing you to save the image as a .png file. 

This is a pretty basic grey colour material and with a 
little time and experimentation with the material 
controls, a much more convincing material could be 
obtained. Read the blender documentation and look at 
examples of materials posted by other users to gain 
more experience in creating realistic materials. 

As most of the parts we have modelled are hidden 
within the dust shields it would improve a drawing 
layout if we included an exploded view.

This can be created by simply moving each of the 
components along the Y axis.

Go into top view NumPad 7 and select the back 
circlip move it constrained to the Y axis away from 
the bearing. Repeat this for all the other components 
spreading them in order along the axis. They can 
easily be reassembled by snapping the cursor to the 
bearing race and then snapping the other 
components to the cursor. 

Reposition the camera to get all the 
components in the view. 

With all the parts being the same material it 
is a little confusing and difficult to separate 
the parts where they overlap. To overcome 
this we can change the material of the 
bearing cage to a brass coloured material.

Select 608-CageA . 
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In the Links and Pipeline panel after the material name is 
the number of objects using the material. 

Click on the number and accept "Single User". This will 
stop the following material changes affecting any of the 
other objects. Rename this material Bronze.

To change the colour of the cage click on the colour 
square in the Materials tab. This will open the colour 
picker. Choose a bronze colour. 

In the "Mirror Trans" tab de-select Ray Mirror and in the 
Texture tab click on Clear to remove the reflection 
image. 

To add this material to the other half of the 
Cage, select 608-CageB and in the links and 
Pipeline tab click on MA:Steel. Select Brass 
from the list. 

To output the picture of the exploded view 
select the Render Buttons and in the Render 
panel press the Render Button.

As before a window will open and the 
Exploded View will be produced.

Press F3 and save the image. 

With the two images created press Ctrl-W and save your .blend file.

In the next section we will create a page template for a scaled line drawing of 
the bearing.
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Camera

Before we go into the process of laying out the drawing view’s, an 
understanding of Blenders camera is needed. 

Perspective Projection

The two images we have created in Part 9 use the 
camera in perspective projection mode and gives 
similar results, as you would get if an actual 
bearing had been photographed. 

The size and shape of the image on the image 
plane is a product of the focal length of the 
camera, distance of the object from the camera 
and the object size. This type of camera will never 
give us the flat-scaled 2D drawing required.

Orthographic Projection

Blender includes  an orthographic mode for the 
camera, which takes a parallel slice, the size of the 
image-plane through the 3D workspace. The size 
of the image plane can be set to suit the overall 
size of the drawing you need to output. 

Printer

The next thing we need to consider is the printer. For engineering purposes 
we are most likely working to a scale of 1 Blender unit equals 1 millimetre and 
the output from the camera is likely to be in 96 DPI (dots per inch) The usual 
output from a printer will be 300 DPI. So how do we get a drawing to scale out 
accurately onto a printed page?

Setting up the Scale

The way I find easiest is to set the camera scale at a multiple of 25.4 and set 
the size X and Size Y in the Format panel of the Render Buttons to an 
equivalent multiple but this time of 300. So if you wanted to have a 1:1 scaled 
image fit onto an A4 page of 11” by 8” you would need to set the camera 
scale to 25.4 x 11 = 279.4, the Format panel Size X: to 8 x 300 = 2400 and 
Size Y: to 11 x 300 = 3300. There is one further requirement as the image is 
set to print at 96 DPI not 300 DPI. This requires the use of an image-editing 
program such as the Gimp or Photo Shop, to change the output size of the 
image to 300DPI.
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If you want to set your page up to print at an exact size and at a scale other 
than 1:1 the correct Camera scale factor and output resolution become a little 
more difficult to set up. The easy solution is to scale your model once you 
have set the camera to suit the page template. 

Page Template

Save anything you currently have open Ctrl W and open a new Blender file 
Ctrl X. We will start by making a page template to suit an 8 x 11inch page, in 
front view add a Plane SpaceBar Add>Mesh>Plane, select and grab the top 
two vertices moving them 277.4mm (25.4 X 11 inches - 2 the original Plane 
size) in the Z axis. This sets the height of the page. Grab the two right-hand 
vertices and move them 201.2mm (25.4 X 8 inches - 2 the original Plane size)  
in the X axis, to set the width of the page. Select all vertices and delete X Only 
Faces to remove the face. This rectangle becomes the page boundary we 
need to work within. In the Links and Materials panel, rename OB:Plane to 
OB:A4pBoundary. (A4p being page size A4 Portrait) 

Next we will set the camera to view this rectangle at the 
print resolution.

Press N to open the Transform Properties panel. Change 
RotX:, Y and Z as indicated.

The Camera will now be parallel to the plane. 

In the Camera panel (Editing Context Buttons) press 
Orthographic.

Set the scale to 279.4 (11 inches x 25.4mm) 

In the Format panel (Render Sub Context buttons) set 
sizeX: 240 (8 inches x 300 pixels) and SizeY: 3300 (11 
inches x 300 pixels) 

Select the camera and in camera view NumPad 0, move 
G the camera so that the outer dotted line aligns with the 
A4pBoundary. 
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Select the A4pBoundary object RMB and copy it Shift-D then 
press Esc to leave it in its original position. 

Tab into Edit Mode and in edge select mode select each edge 
individually and move it G 12mm towards the centre of the 
rectangle, constrained to the X or Y axis. 

This rectangle will form our page border, it could now be rendered 
as a wire object but the output will only be one pixel wide, so we 
need to thicken the line.

Select the Left hand edge and extrude it -0.5mm on the X axis. 
Extrude the Right hand edge 0.5mm on the X axis. Box select the 
three edges making up the top of the border and extrude these 
0.5mm on the Z axis and repeat this on the bottom edge but -0.5 
on the Z axis.
Rename this object A4pBorder 

Tab into Object Mode and Add a new Plane SpaceBar 
Add>Mesh>Plane. This will be used to create the edge ruler's. 
Move the Plane to the bottom left corner of the A4pBorder and 
resize to X axis 6mm and Y axis 0.5mm. 

Select all vertices A and copy Shift-D the vertices on the Z axis 
10mm.

This will form the marks for a ruler that runs along the outer edge 
of the border.

Grab G the two Left vertices and move them on the X axis 2mm. 
then select all the vertices A. 

In the Modifiers panel click Add Modifier and select 
Array from the pop up menu.

The Array modifier will copy the selection by the 
number set in the Count: field and offset each copy. 
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Set Count:13, De select Relative Offset, select Constant Offset and 
set Y:20. The selected lines will be copied up the side of the 
border. 

Tab into Object Mode and select A4pBorder object. Tab into Edit 
Mode for this object and select one of the long bottom edges. Snap 
the cursor to the edge Shift-S Cursor>Selection. The cursor will be 
repositioned in the middle of the edge. Tab back into Object Mode. 

Select the Plane object and copy it Shift-D then press Esc so it 
does not move position. Set the Pivot Point to Cursor select. 

Mirror the copied edge ruler Ctrl-M and accept 
"X Local". 

The Border rules will now be mirrored onto the right hand edge.

Select both border rulers and copy them Shift-D then rotate them 90 degrees 
R-90. These will form the top and bottom rulers. 

Select the A4pBorder object and snap the cursor to the 
object centre Shift-S Cursor>Selection. Select the bottom 
ruler and snap this to the cursor Shift-S 
Selection>Cursor.

In the Modifier panel, reset the Array count to 9 

Repeat this on the top edge but snap the 
cursor to the top left vertex of the A4pBorder 
object (Edit Mode). 

It may be necessary to adjust the position 
slightly to ensure the rulers are touching the 
A4pBorder object.

It doesn't matter that the rulers overlap the 
border slightly, as we will be using a 
shadeless texture.

With the top ruler selected press Apply in the 
Array Modifier panel. This will convert the 
Array into a mesh objects.

Repeat this on the other three ruler's. 

Shift-RMB Select all the rulers and the 
A4pBorder Object ensuring the A4pBorder 
was the last selection and join them into one 
mesh Ctrl-J. 
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All that's left now is the Title Box.

Add a Plane object and move it just inside the 
lower right hand corner. Resize the plane to 
0.5mm high by around two thirds the width of 
the border. The exact size will be dependent 
on the text fields you want to put in it. 

Copy the plane several times in the Z axis at a 
height to suit your text. I have used 7mm for 
the small text and 10mm for the larger text. 
Form a space for the title box by shortening 
one of the lines. 

Copy one of the lines Shift-D and Rotate it 90 
degrees. Position it on the right hand side of 
the Title Box and adjust its length to suit the 
horizontal lines. 

Copy this edge to form the other vertical edges 
and resize them as necessary. 

Tab into Object mode and with the Title Box 
selected, Shift-RMB select the A4pBorder 
object and join the meshes Ctrl-J. 

The Border and Title Box are now one object.

We now need to add a colour for the border. 

In the Materials tab of the Material sub context buttons, I 
have set R, G, B to 0 for a Black colour.

Select the shadeless button so the colour won't be 
affected by any lamps in the scene.  

In the links and Pipeline panel press the small button with 
the car on it. This will give the Material an automatic name 
representative of the colour chosen. In this case Black. 
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We now need to add some test to the Title 
Box. LMB click over the Title Box to set the 
cursor position. Press the Space Bar to open 
the Toolbox and choose Add>Text, a text 
object will be placed on the view, but much to 
small to see. 

In the Font panel of the Editing Context 
Buttons change Size: to 10. Backspace to 
remove the word Text and type in 608 
Bearing. Scale S and move G the text so it fits 
in the Title Box. 

To add the same Black Material to the text in 
the Links and Pipeline tab, click the Arrow box 
to the left of Add New and select Black from 
the pop up menu. In the Link and Materials tab 
of the Editing buttons change the name from 
OB:Text to OB:A4pText. 

Tab into Object Mode and copy the text Shift-
D to another area of the Title Box and Scale it 
to fit. Tab into Edit Mode and Backspace to 
clear the text, then type in the new text. 
Repeat this for all the fields of the Title Box

One further useful addition is to copy a text object 
outside the Boundary object and type in the camera 
scale, Format size x and size Y and the printer dpi. 

In the Outliner you will now have a grouped list of 
A4p objects that can be easily appended into any 
.blend file you are working on

The settings needed for the camera will be 
appended along with the Border 

All that is left for you to do now is make more 
templates in different page sizes. 

Finally save your work as PageTemplate.blend 
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Layers

Up to now everything has been produced on layer one of the twenty available 
layers within Blender. By organising your work onto different layers, Blender 
allows you to set different lighting and rendering parameters for objects on 
different layers. As we need to combine some of the objects rendered with the 
edge render facility of blender, together with others that do not use the edge 
setting we will need to organise our layers and render output.

Firstly we will set our scene. If you still have a .blend file open, save your work 
Ctrl-W and then open a new file Ctrl-X.
Save the new file Ctrl-W as "608-Layout.blend".

Append all the A4p objects from the PageTemplate.blend 
file produced in part 10. Shift-F1 to open the File 
Browser window in Append mode and from the 
"PageTemplate.blend" file LMB click Object then RMB 
select all the A4p objects. Click on Load Library to bring 
them into the new file. They will be placed on Layer one, 
as this was the layer they were created on. 

Now append all the parts of the 608 Bearing into the file. 
In front view NumPad 1 select all the components of the 
bearing and move them G to the top left corner of the 
page template. As the bearing is only 22mm across we 
will scale it 2:1. With all the components still selected 
press S for scale then 2 for the scale factor. The bearing 
will double in size.

Open the Outliner as detailed in Part-4. All the 
components of the Border and Bearing will be listed. 

Copy the bearing (all bearing components selected) Ctrl-
D and move the copy on the X-axis to the right hand side 
of the original. In top view NumPad 7 Rotate the bearing 
90 degrees. Go back into front view NumPad 7. We now 
have a front and side view, within the page border. 

With the side view still selected copy the components and move 
them below the original. This will be used to create a part 
section through the bearing. 
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The Front, Side and Part Section view of the bearing 
needs to be rendered using Blenders edge render 
facility and therefore needs to be rendered separately 
from the rest of the layout. 

Box select the three bearings and press M which will open the Layer Move 
panel click on layer 2 and press OK. The two bearings will disappear from 
view until layer 2 is activated. To bring the bearings 
back into view, Shift-LMB on layer 2 in the view 
header’s layers panel.

If your computer is slowing down due to the amount of detail 
in the bearing’s you can delete the components that won’t be 
seen. I have removed the balls, both cages the back dust 
shield and circlip from the front view and all but the 608-Race 
from the side view. The section view needs all the 
components. 

We now need to set the material to give a line drawing 
effect. Select the race of the side view and in the 
Material panel of the Material buttons, change Col to 
white (click on the grey square next to it and choose 
white from the colour picker)
Click Shadeles so the colour isn't affected by any lamps 
in the scene. 

In the Link and Material panel of the Edit buttons select 
"2 Mat 2" to choose the second material and press 
Delete to delete it. 

In the Links and Pipelines panel click on the small Car 
button to auto name the colour. 

In the Mirror Trans tab make sure Ray Mirror is not 
selected. 

In the Texture tab click Clear to remove the texture. 

Change the SizeX: and SizeY: to those detailed on the 
page template, (text outside the Page Border). Set the 
output to PNG and select RGBA.

The RGBA button will save the render with a transparent 
background allowing us to overlay the lined drawing over 
the standard render. 
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In the Render Layer tab of the Render Buttons click 
Layer 2 which will restrict the render to the objects on 
this layer. 

On the Output tab click Edge and then Edge 
Settings.

In the Edge Settings pop up window change Eint: 
to 2.

This will set the line intensity so it predominantly 
highlights the main edges. 

Click on the Camera and in the Edit buttons Camera panel click on 
Orthographic to use the orthographic camera mode.

Set the scale to 279.4 as detailed on the page template.

With the mouse over the 3D view press N to open the Transform Properties 
window and set the camera view parallel to the Page Template. RotX:90, Y:0, 
Z:0.

Align the Camera with the page boundary. 

In the World panel of the Material buttons set the 
background colour to white.

The Front and side view's are now set-up to give us a 
line render but before we do this we need to section 
and scale the Part Section view. 

De select All then in wire view Box select the components of the 
bearing we are going to use for a section view.

Go into local view NumPad /. Then Shift-RMB the outer race and 
join all the components Ctrl-J.

Its easier to cut through the bearing as a single mesh than to 
have to repeat the cuts for each component.
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In top view NumPad 7 De select All the vertices then Box select all 
the vertices to the front of the bearing centre (not the vertices on the 
centre line).
Delete X these vertices.

Zoom in SW on the centre of the bearing and delete any 
remaining vertices that were missed by the Box select.

In front view NumPad 1 repeat the process of 
selecting and deleting vertices. This time though 
remove the lower quadrant of the bearing 
Not all the edges finish on the horizontal centre 
line. As only the inside diameter of the bearing will 
be seen at this location, make sure every vertex 
below the centre line is removed. 

In top view Box select the single row of vertices on the bearing 
centre line.

Copy these vertices Shift-D and move them on the Y axis 
forward of the bearing.

Separate them from the bearing P. 

We will use this slice through the bearing to add the hatch 
pattern to the section view. 

Tab into Object Mode and go into Global view 
NumPad /. select the slice through the bearing 
we have just created and go back into Local 
view NumPad / for this object. Tab into Edit 
Mode. 

Link select L each closed area of the slice and fill the area Shift-F with faces. 
Beautify the fill Alt-F to give a cleaner mesh. 

Blender - Precision Modelling Guide 
By: Robert Burke www.rab3d.com - 82 -



Press A to de-select the vertices then repeat the process 
on the next closed area.

Continue until all the faces of the section are filled. 

De-select All vertices. 

Link select the two areas that represent 
the bearing race and in top view 
NumPad 7 move them G forward of the 
other areas of the bearing, on the Y axis.

Repeat this for the other areas of the section making sure no two components 
touch each other on the same plane.

This is necessary so the Edge Render filter can detect the edge of each 
component. 

Link select the inner and outer race sections.

We are now going to add a hatch pattern to this area.

In the Link and Materials panel of the Editing buttons press 
"New" to add a new material.

Press Assign to assign this material index to the selected 
vertices. 

In the Texture Buttons 
Texture tab click the number 
next to the TE:Tex box and 
accept single user. Add New 
to add a new texture. In the 
Texture Type button click 
None and then select Image 
from the pop up menu.
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You will need to either create your own or download the hatch patterns from 
www.rab3d.com in Part-11 of the 608 bearing tutorial, download RMB Click 
on the hatch patterns  and "Save Target As..." to save the images.

In the Image panel load "LineAngle1.png". To make the hatch render smaller, 
repeat the texture on the section by changing Xrepeat: and Yrepeat: to 2 in 
the Map Image panel. 

If you render the image at this stage a hatch pattern 
will be created on the bearing race.

To add further hatch patterns Link select the area 
to hatch (for this example both halves of the 
bearing cage). In the Links and Materials panel of 
the Edit Buttons Click "New" then "Assign". Material 
3 has been created and assigned to the selected 
vertices. In the Texture panel set the texture to 
single user. In the Image panel of the Texture 
Buttons change the texture to "LineAngle2.png" 
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Repeat this process until all the section faces are 
filled with a hatch pattern.

Change Xrepeat and Y repeat to resize the 
textures. 

We are now ready to render the line drawing. In the Render Buttons, Render 
panel , press "Render". Or use the keyboard shortcut F12.

When complete close the Render window and save the image F3 as 608-
Line.png.

Save you work Ctrl-W 

For the rest of the layout we won't 
need to use the edge rendering 
setup, so on the Render buttons 
Output tab de-select edge. In the 
Render Layers tab select layer 1

To add dimensions to the layout we will use the Blender 
Caliper script. The script doesn't come already loaded with 
blender but can be downloaded from alienhelpdesk.com

Follow the instructions on their site to load the script. And 
read the user documentation. 

In blender split the view and open a script window as 
detailed for the Bevel script in part 4. But this time load the 
"Blender Caliper" script from the "Wizards" section of the 
scripts pop up list. 

It may also be necessary to first click "Update Menus" from 
the same pop up list to register the script in Blender. 

Before we can dimension the bearing we need to add some 
points to dimension.

In Edit Mode select Shift-RMB the two vertices at the 
widest point of the bearing on the same edge loop.

Copy these Shift-D in the Z axis below the bearing. 
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Extrude these vertices in the Z axis to the point where you 
want the dimension to be. 

Then extrude them again so the dimension lines will pass 
the dimension arrow. 
Shift-RMB select the 6 vertices of the dimension line and 
separate P them from the 608-race mesh. 

Tab into Object Mode and select the Dimension Lines. 
Tab back into Edit Mode for this object. In the Edit Buttons 
Link and Materials panel change the objects name to Dim. 

Select the two middle vertices of the dimension lines and 
with Blender Caliper set as indicated above press 
"Measure".

A dimension and arrowed line will be created.

Repeat this process for the other dimensions, 
then Tab into Object Mode and select all the 
dimension lines and Join them Ctrl-J to the Dim 
object. 

Tab into Edit Mode for the Dim object and select 
all the vertices on the left hand dimension lines. 
To thicken these lines for rendering extrude 
them -0.2mm on the X axis.

Repeat this on the right hand lines extruding 
them 0.2mm on the x axis. 

Link select one of the dimension lines and copy it Shift-D. 
Move it over the bearing and re shape it to form the section 
markers. 

In the Material buttons Links and Pipeline panel change the 
material to Black.

In Object Mode copy one of the dimensions text objects and Tab into Edit 
Mode. Change the text to Z, Tab back into Object Mode. Move Z to the 
section marker. Copy this and move it to the other marker. 
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Select one of the dimension text objects and copy it to 
below the section view. Change the text as indicated and 
scale the text to a suitable size.

To finish editing text, fill in the fields in the Title 
Box. 

The final part to the layout is to add the 3D image of the 
bearing created in Part 9, along with the exploded view.

to do this add a Plane and Move it G to the top right 
corner of the layout. Scale the plane Shift-S to fit in the 
area next to the line drawing. 

In the Material buttons Links and Pipeline panel add 
a new material. In the Material panel set the material 
to Shadeless.

In the Texture buttons Texture panel add a new 
texture. set the texture type to Image and in the 
Image panel load the rendered 3D view created in 
Part 9. 

The image won't be visible on the plane until it is 
rendered. 

To ensure the Plain is set at the correct aspect ratio 
for the image, in Object Mode select the Plane and 
press Alt-V. The planes shape will change to suit the 
loaded image. Reposition the plane if necessary.

Add another Plane in the lower right area of the 
layout and repeat the above process but this time 
load the Exploded View.png from Part 9

If you render the Layout now F12 you will get an 
image with all the Layout elements except the line 
drawings. 
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In the Format panel of the Render 
Buttons leave the output as PNG 
but change the image format to 
RGB. We don't need an alpha 
channel on this image.

Press F12 to render the image. 
Close the render window, press F3 
and save the image as 608-
Layout.png

The final stage is to combine the 
608-Line.png created above with 
the 608-Layout.png.

This can be carried out either using 
the Node Editor within Blender or 
by using an external image editing 
program such as gimp.

The Node Editor is to complex to 
cover in this part of the tutorial so, 
In the image editor of your choice 
open both 608-Layout.png and 
608-Line.png. Copy 608-Line.png to the clipboard and paste it into 608-
Layout.png as a new layer. The line drawing will sit over the layout drawings 
without obscuring them because it was saves with a transparent background. 
Finally in the Image Editing program resize the image to 300 dpi.

The final result gives a good layout drawing, easily capable of communicating 
the essential elements of a product design. With sufficient planning and 
forethought any component could be created, rendered and dimensioned in 
Blender.
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Part 1 Guide Roller Design Concept

Linear Guides 

Many engineering situations require the movement 
of machine parts along set axes. On traditional 
machine tools this was historically achieved by 
using accurately machined and hand scraped 
guides that run on planed or ground slides. This 
method of construction when done correctly offers a 
great deal of rigidity between the components but 
still allowing movement in one axis. The drawback 
of this type of slide is the initial high load required to 
overcome the starting friction. On a traditional 
machine tool this simply meant the operator would 
have to exert a little more force on the hand wheel 
to start the slide moving. 

On Industrial CNC machines overcoming friction 
to allow increased speed and or smaller drive 
units has brought about the development of linear 
bearings. These usually contain re-circulating balls 
or rollers that run along hardened and ground 
guides. Alternatively larger drive units are fitted to 
traditional slide ways. In both situations 
overcoming friction can be a costly process. 

As an alternative to recirculating ball races, some 
industrial processes use a ‘V’ roller guide running 
on a pre formed track. Though not offering the 
same rigidity or accuracy of the recirculating ball 
races they are perfectly adequate for a light duty 
machine. 

 
As a hobby engineer the use of expensive OEM components such as linear 
bearings is not affordable, therefore an alternative must be used. The original 
router used “Oilite Bushes” running on 18mm Bright drawn steel shafts. The 
shafts proved amply strong enough for the job. The problem was the inability 
of the stepper motors to overcome the starting friction, especially when the 
shafts became slightly contaminated with dust from the machining process. 

Though Industrial 'V' rollers are still quite expensive it is a simple process to 
machine an alternative that will run on the existing 18mm BDMS slides. The 
following tutorial shows how the 608 bearing model was used as a base to 
construct the ‘V’ roller and axle.
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If you are currently using Blender save your work Ctrl-W and start a new 
project Ctrl-X. Delete the default cube X.

This section assumes you have completed and understood the 608-Bearing 
tutorial. 

As the components will be built from the 608 Bearing geometry 
the first step is to append the low vertices 608 bearing into the 
scene. Press Shift-F1 and navigate to the folder containing the 
608-BearingSmall.blend made in the Bearing tutorial. Click on 
Object and select the OB:608-BearingSmall model, Press Load 
Library and the Bearing will be loaded into the scene. (A more 
detailed description of appending is given in 608-Part 8.)

Split the 3D view and open an Outliner window. (If you cant 
remember how this is done it is described in 608-Part 4.) 

Some of the design constraints I have are based on the material available to 
me. I currently have slides at 18mm diameter so I will reuse these. The ‘V’ 
Roller will be made the same width as the slide to maintain as small a 
footprint as possible. I have some 45mm diameter BDMS that I will use for the 
rollers, so I need to make sure the outside diameter is less than this. 

In side view NumPad 3 Copy the Bearing Shift-D and move it 
in the Y-axis 11mm. This will set the bearings with an external 
width of 18mm. 

Next we need to add a cylinder to represent the 18mm 
diameter slide, centrally to the bearings. Shift-RMB select 
both Bearings and snap the cursor to the middle of them 
Shift-S Cursor>Selection. Add a Cylinder press Space Bar to 
open the Toolbox then select Add > Mesh > Cylinder. From 
the popup menu change radius to 9 and length to 20, press 
Enter to accept. Tab back into Object Mode and with the 
cylinder still selected, move it below the bearings G (move) Z 
to constrain it to the Z-axis and drag it to a position below the 
bearings. 
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We will now use the outer profile of the bearings to form 
the bore of the V-roller. Shift-RMB select both bearings 
and copy them Shift-D then press Esc to leave the copy 
over the top of the original bearings. With the two new 
bearings still selected join them into one object Ctrl-J. In 
the Link and materials panel rename the object OB:V-
Roller. Press NumPad / to go into local view for the V-
Roller and Tab into Edit Mode.

Now is also a good time to save your work. Pres Ctrl-W 
and save the file as V-Roller.blend 

Shift-Alt-RMB Select the second outer loops of vertices 
from the bearing outside diameter and the loops indicated 
between the bearings. If you added chamfers to the 
bearing choose loop A otherwise choose loop B.
In total 4 loops should be selected. 
 

Delete these 4 loops X 
Vertices. This will isolate the 
outer section, from the inner 
part of the bearing.

RMB select a vertex on the far left side of the bearing and snap 
the cursor to it Shift-S Cursor>Selection.

Change the Pivot point to 3D Cursor.

Alt-RMB select the loop of vertices on the 
outside diameter of the bearing. Scale 
these along the Y-axis to the 0 cursor 
position. 
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Repeat this on the Right hand side of the other bearing.

Press A to deselect all vertices then with the cursor over the inner 
portion of a bearing press L to select all linked vertices.

Delete the selected Vertices X.

Repeat this on the other Bearing.

You are now left with two bores 
where the bearings sit inside the 
V-Roller.

These now need to be joined 
together. 

Shift-Alt-RMB select the inner loop of both bearings.

Press F to open the Make Faces menu. A new option is 
available Skin Faces/Edge-Loops. 

Pressing the Skin option will automatically build faces 
between the two vertex loops. It works the same as the Loft 
function in many 3D CAD packages. 

The bore of the V-Roller could be called finished at this stage, but its not really 
good engineering practice to have the inner fillet radius of a bore the same 
size as the object that is going to fit into it. 
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To facilitate a better fit for the bearing it is better to 
have a bore fillet with a smaller radius than that of the 
bearings outer edge. To achieve this we need to delete 
the loops making up the fillet and re model them.

Shift-Alt-RB Select the inner loops of the two fillets 
and delete them X. 

RMB select the inner loop of the left hand bearing 
location and move the loop G on the Y-axis 0.3mm. This 
will allow us to reconstruct the fillet with a radius of 
0.3mm, half the size of the outer fillet on the bearing. 

Select the inner loop of the right hand bearing location and move 
this -0.3 on the Y-axis.

In front view NumPad 1 press Z for wire frame view then 
B-B to open the paint select tool, select the top vertices.

Hide all the other vertices Shift-H. 

Go into side view NumPad 3 and RMB select the first 
vertex that will be used to spin the new fillet radius (A) and 
Extrude it on the Z axis -0.3mm. This gives us the centre 
point for the fillet. 

Snap the cursor to the extruded vertex Shift-S Cursor>Selection. 
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Reselect vertex A (the vertex we are going to spin to make the 
new radius) and in the Mesh Tools panel set Degr:90 and 
Steps:5, Press "Spin" to form the new radius.

Select the vertex on the fillet centre and delete it X.

elect the two vertices shown opposite and add an edge between 
them F.

Repeat this for the Right hand side, selecting vertex B, but in the 
Mesh Tools panel deselect "Clockwise" so the fillet is spun in 
the opposite direction. 

Shift-RMB select both sets of fillet vertices including 
those that join to the existing V-Roller bore.

Go into front view NumPad 1 and Tab into Object 
Mode.

Snap the cursor to the Object Centre Shift-S 
Cursor>Selection then Tab back into Edit Mode. 

In the Mesh Tools panel set Degr:360 and Steps:32, 
press spin to generate the new fillet. Select All and 
Remove Doubles W. 

The bore fillet will now be at the smaller size.
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Go back into Global View NumPad / and you will see 
the bearings sitting in the newly created bore. At this 
stage we don't need the Bearings in the view. In the 
Outliner click on the eye icon for the bearings which 
will close, and remove them from view. 

In side view NumPad 3 select one vertex that is sitting on the 
V-Rollers horizontal centreline. Extrude this vertex in the Z-
axis -22mm, snap the cursor to this vertex. This will be used 
as a reference to set the outside diameter.

Select the two bottom vertices on the outer edges of the V-
Roller. We will build the cross section of the V-Roller from 
these.

Extrude the two bottom vertices in the Z-axis with a length 
similar to the reference vertex. 

To position them at the same Z-axis location as the reference 
vertex Scale them constrained to Z and to a scale location of 
0.

Delete X the reference vertex.
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Add an edge between the two new vertices.

Subdivide Multi W the bottom edge with 2 divisions.

This will split the bottom edge into three equal divisions of 
6mm each.

In order to cut the angles on the roller we first need to cut a 
central groove. On my lathe I will do this with a 3mm parting 
tool. To add the groove select the two central vertices. 
Change the Pivot to "Median point" and scale them by a 
factor of 0.5 

To give a small flat at the edge of the V-Roller Extrude the 
bottom left corner vertex in the -Z direction then Extrude this 
vertex in the Y-axis 1mm, then Extrude this vertically 
crossing the bottom edge. This will be used to cut a new 
vertex 1mm from the corner of the bottom edge.

Select All the press K for the Knife tool, select Knife (Exact) 
from the sub menu and holding down Ctrl snap the cut line 
to the reference edge crossing the bottom edge. A new 
vertex will be created. Delete X the reference vertices.

Repeat this to cut a vertex from the right hand corner. 

Select the two centre vertices and move them G in the Z-
axis 6.5mm. This will create the V profile with an angle of 45 
degrees.
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To complete the groove Extrude "Only Edges" the central 
edge in the Z-axis 2mm, then delete the lower central edge 
X "Edges". 

The roller profile is now ready to spin around the central 
axis. Select all the vertices of the profile, including those 
attached to the bore.

Go into front view NumPad 1 and Tab into Object Mode. 
Snap the cursor to the object centre Shift-S 
Cursor>Selection, then Tab back into Edit Mode.

In the Mesh Tools panel set Degr:360 and Steps:32, then 
press Spin. 

The profile will be created around the bore. Select All, 
Remove Doubles W and Set Smooth W.

In the Modifiers Tab ass an Edge Split modifier and keep the 
default settings. (A more detailed description of adding the 
Edge Split modifier is contained in 608-Part 4)

The V-Roller is now complete. In the Outliner open the eye 
icon for the two bearings to bring them into the view. 

Save your work Ctrl-W

This has been a fairly long-winded way to construct the 
roller, however I have chosen to do it this way to introduce 
the Skin Face/Edge loops tool and methods to accurately 
modify a 3D mesh. In practice it would be much Quicker to 
simply construct a complete cross section and spin it around 
the centre axis.

In the next section we will construct the axle.
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We have now got the V-Roller with two bearings inside it, so the next thing is 
to design the axle. I intend to make aluminium castings to hold four rollers and 
the lead screw nut and at this stage a casting thickness of 10mm seems 
appropriate. One end of the axle needs to fit into the casting the other end 
needs to hold the bearings. These are the governing factors for the length and 
profile of the axle. 

If it is not still open from part one, open V-
Roller.blend. 

In the Outliner make sure the eye icon is open 
for the two bearings and closed for the V-Roller 
and Cylinder.

We only need the bearings in view to position the Object 
Centre for the axle and the section of the axle profile that 
the bearings sit on. 

RMB Select the right hand bearing and Tab into Edit Mode. Alt-
RMB select a loop of vertices on the outer right hand edge of the 
bearing and snap the cursor to the centre of this loop of vertices 
Shift-S Cursor>Selection. Tab back into Object Mode.

Go into side view NumPad 3.

Press the Space Bar and from the Toolbox menu select 
Add>Mesh>Plane. In the Link and Materials panel change the 
name to OB:V-RollerAxle. 

Shift-RMB the top right hand vertex to deselect it, then press X to 
delete the remaining three vertices.

RMB the remaining vertex to select it, then Tab into Object Mode. 
(The vertex will be easier to locate when we Tab back into Edit  
Mode for the V-RollerAxle). 
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Select the right hand bearing and Tab into Edit Mode for 
this object. Select the top right hand vertex of the bearing 
bore (the vertex on the bearing bore not one of the fillet  
vertices, check you have the correct vertex in front view 
NumPad 1), snap the cursor to this vertex Shift-S 
Cursor>Selection. Tab back into Object Mode. 

In the Outliner select V-RollerAxle and Tab into Edit Mode. The single 
vertex is selected so snap it to the cursor Shift-S Selection>Cursor. Tab 
back into Object Mode.

Select the Right Hand Bearing and Tab into Edit Mode. Select any 
vertex on the outer right hand edge and snap the cursor to it. Tab 
back into Object Mode.

In the Outliner select V-RollerAxle and Tab into Edit Mode. 

Make sure the pivot point is set to 3D cursor.

With the single vertex still selected Scale the vertex along the Y-axis to 
the cursor position 0.

The vertex is now positioned aligned to the bearing 
bore and right hand edge. In side view NumPad 3 
Extrude the vertex along the Y axis -17.5mm. RMB 
select the right hand vertex and Extrude it along the Z-
axis 2mm.

In the Outliner close the eye icon for the two bearings 
to remove them from view. 

You are left with two edges that when spun around the 
Object Centre will form the bearing location area of the 
axle. 
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From the two edges that were positioned on the bearing bore extrude the 
following profile constraining the extrusions to the Y or Z-axis and dimensions 
indicated. The end chamfers are created by extruding 0.6mm in the Y-axis 
then grabbing and moving the vertex -0.6mm in the Z-axis. When complete 
this will form the basic profile of the axle.

A little more refinement is required before we spin the axle 
around the Object Centre. Fillet radius and chamfers need 
to be added.

First we will add a fillet radius of 0.3mm to the inside angle 
of the central up-stand.

Select the inner corner vertex indicated and Extrude this in 
the Z-axis 0.3mm to point A (vertex to spin), then extrude 
this vertex to point B (fillet centre). 

Snap the cursor to the vertex on the centre point. 

In the Mesh Tools panel set Degr:90 and Steps:5, then 
press Spin. The corner fillet will be formed.

Select the corner vertex and the fillet centre vertex (B) and 
delete them.

Before connecting the fillet to the rest of the axle we can add a 
chamfer to the top edge. 
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Select the vertex on the top edge 
above the fillet and move it G 
along the Y-axis 0.2mm. Now 
Extrude this vertex Y -0.2, then 
Grab this and move it Z -0.2 A 45-
degree chamfer has been added 
to the edge.

Reconnect the other end of the 
fillet to the end of the bearing 
location.

Add a similar fillet and chamfer to 
the other side of the central up-
stand. 

Tab into Object Mode and snap 
the cursor to the Object Centre.

Tab back into Edit mode. 

Go into front view NumPad 1 and select All vertices.

In the Mesh Tools panel set Degr:360 and Steps:32, 
then press Spin. The axle will be formed.

When fitting the axle into the casting we need to be 
able to stop it rotating whilst tightening the retaining 
nut. The next step will be to add some spanner flats to 
the central flange. 

Tab into Object Mode and add a Plane. Select the two 
right hand vertices and move them G on the X-axis 
3.9mm.

Select the two left hand vertices and move these 
-3.9mm on the X-axis.

This will create a guide to cut flats 9.8mm apart for a 
10mm spanner. 

Select All and Scale the Plane on the Z-axis till it is 
larger than the flange. 
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Tab back into Object Mode and with the Plane still 
selected Shift-RMB select the axle. Combine the two 
Objects into one Ctrl J.

Tab back into Edit Mode and cut new vertices to form the 
two spanner flats Knife (Exact) snapping the cut to the 
vertices of the plane Ctrl-LMB. 

De-select All, then Box select the vertices that are outside 
the spanner flats.

Delete X these vertices.

Shift-Alt-RMB select the loop of vertices around the opening of the 
spanner flat.

Add faces to the opening Shift-F, then beautify the fill Alt-F and 
then convert the created triangles to quads Alt-J.

Repeat this on the other spanner flat. 

To complete the axle select All vertices, Remove 
doubles W and Set Smooth W. You may also need to 
recalculate the normals to the outside Ctrl-N.

To create a smooth surface with sharp edges, add an 
Edge Split modifier with the default settings.

Press Ctrl-W and save your work.

At this stage I have deliberately left the axle with plane ends rather than 
generating a threaded profile. In large assemblies the axle will use 
substantially less computer overheads than one with a detailed thread profile.

In part 3, I will detail how to set up and use the screw function to create a 
detailed thread suitable for producing a realistic render. 
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Continuing with the V-Roller assembly, in the Outliner 
open the eye icon for the two bearings and V-Roller. The 
assembly is starting to take shape but still missing a 
retaining nut and washer. 

The nut should also impart a small amount of pre-load 
onto the bearing to remove any side piay. In true 
skateboard fashion I am going to use a 6mm nyloc-
locking nut and washer.

To locate the washer and nut we only need the bearings in view, so in the 
Outliner close the eye icon for the V-Roller and V-RollerAxle to remove them 
from view. 

Select the left hand bearing and Tab into Edit Mode. 
Alt-RMB select a ring of vertices on the far left side of 
the bearing and snap the cursor to the centre of them. 
Tab back into Object Mode.

Press the Spacebar to open the Toolbox and select 
Add>Mesh>Circle. From the pop-up menu leave 
vertices at 32, but change Radius to 3.2 then press OK 
to accept. This will form the 6.4mm inside diameter of 
the washer.

Extrude (Only Edges) this vertex ring then press Esc to 
leave it in place. We will scale the extruded vertices to 
form the outside diameter. 

The Outside diameter of the washer is 12.5mm so to 
find the required scale factor:

12.5 / 6.4 = 1.9531
With the extruded vertices still selected Scale 1.9531 to 
form the outside diameter.

The thickness of the washer is 1.6mm so select All and 
Extrude (Region) Y -1.6

The basic profile of the washer is formed, we now just 
need to add a chamfer on the corners. 
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Go into edge select mode and Shift-Alt-RMB select the two 
outer and two inner edges. 

Using the Bevel Centre script and following the details given in 
608 Part-4 add a 0.1mm chamfer. Back in vertex select mode 
select All and Set Smooth W, in the Modifiers tab add an Edge 
Split modifier with the default settings. If Black areas are 
present on the surface of the washer press Ctrl-N to 
recalculate the normals to the outside. 

The washer is complete but before going into Object Mode 
we need to set the cursor ready to add the final 
component. Alt-RMB select one loop of vertices on the left 
hand side of the washer and snap the cursor to the centre 
of these. Shift-S Cursor>Selection. 

Tab into Object Mode and in the Link and Materials panel 
rename the washer OB:6mmWasher. 

The next thing needed is to model the M6 nut. 
Some consideration should be given to how many 
vertices to use for the nut, as the external 
hexagonal section will only require 6 vertices and 
internal circle will require more. 

Some extra detail on the external profile will be 
required to form the curves on the top edge of the 
nut so it would simplify the modelling to keep the 
same number of vertices on the outer and inner 
diameter. 

Six vertices should be enough to form the curved detail on the top of the nut 
so with six sides this equates to an inner circle of 36 vertices. 

In front view NumPad 1 press the Spacebar to open 
the Toolbox and add a Circle with 36 vertices and a 
radius of 3 Add>Mesh>Circle. 

Now add a circle with 6 vertices and a radius of 
5.7735 This will form a hexagon with 10mm across 
the flats. With the 6 outer vertices still selected, 
subdivide each edge of the hexagon with 5 vertices, 
W Subdivide Multi. Change the number in the popup 
menu to 5 and press OK to accept.
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Select All and fill the space between both loops of vertices with faces Shift-F. 

To improve the fill pattern and remove the long thin triangles press Alt-F 
(Beautify Fill). Repeat the beautify fill command several times until the internal 
edges no longer change.

To convert the triangular faces into quads press Alt-J. 

Blenders beautify fill attempts to produce triangles with the 
shortest possible sides and has overcompensated on the 
corners of the nut. If left like this the mesh would produce 
ugly edges when bevelled. It's worth manually rearranging 
these corners to form quads.

In edge select mode Shift-RMB select the two edges 
indicated and delete them X (Edges). 

In vertex select mode select 4 vertices (A, B, C, & D) and insert a 
face F, select the next four vertices (C, D, E & F) and add the 
next face. The corner will now have a much better face pattern. 
Repeat this until all 6 corners are done.

To make modelling easier we need to rotate the nut so two flats 
are parallel to an axis. Select All and Rotate -15 degrees. 

To make the side faces of the nut Shift-RMB select the seven 
vertices of the top edge and Extrude them Y -4.

To form the radius on the top of the side face we need to spin 
a vertex from the faces bottom centre vertex. Select the vertex 
indicated and snap the cursor to it. 

To determine the angle of the spin, with the centre vertex still 
selected Shift-RMB select the two vertices on the corner of the 
opposite edge and temporarily form a triangular face. With the 
face selected click on the Edge Angle button of the Mesh Tools 
1 panel. The corner angles of the triangle will be displayed in 
the view. The spin angle is 71.635 degrees. Press Ctrl-Z to 
remove (undo) the triangle 
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In top view NumPad 7 select the bottom right hand vertex 
indicated and in the Mesh Tools panel set Degr: 71.635 and 
Steps:6.

Press Spin and the ark at the top edge of the face will be 
formed.

Shift-RMB select two corresponding vertices and merge them 
together Alt-M at the vertex point on the ark. The selection 
order will determine whether you choose "at first" or "at last" 
from the pop-up menu. 

Merge the rest of the vertices on the top edge of the nut face 
to the ark using this method. 

Shift-RMB select all the vertices on the side face of the nut, 
then Tab into Object Mode.

Snap the cursor to the object centre Shift-S Cursor>Selection. 
Tab back into Edit Mode. 

In the Mesh Tools panel set Degr:360 and Steps:6, press Spin 
Dup and the other sides of the nut will be generated.

Select All and Remove Doubles W. 

Alt-RMB select the inside diameter of the nut and Extrude it 
on the Y-axis -5mm, then extrude it on the Y-axis a further 
1mm. 

Snap the cursor to the centre of the last loop of vertices.

The extra loop of vertices will allow us to set a different 
material for the nylon insert of the nut. 
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Select the centre vertex of the ark on the top face of the nut and 
extrude it on the Y- axis. 

Check the Pivot Point is still set to 3D Cursor and Scale the 
vertex on the Y-axis to the cursor position 0. 

The above scale has set the vertex level to the top edge 
of the nut, but this edge needs a 0.5mm fillet radius. Grab 
the vertex and move it Y 0.5, then extrude it on the Z-axis 
-0.5 to set the centre of the fillet. Snap the cursor to this 
vertex, then select the previous vertex.

In the Mesh Tools panel set Degr:90 and Steps:5 and 
Spin the fillet radius.

To form the profile of the nylon insert we need to move the 
inside diameter back slightly. 

Alt-RMB select the inside diameters top loop of vertices 
and move it G on the Y-axis 0.5mm. 

To complete the top profile of the nut extrude the 
top vertex of the inside diameter to the 
dimensions shown, constraining to the required 
axis and dimensional input.

Form the chamfer by Extruding the vertex Y 
-0.25 then Grabbing this vertex and moving it Z 
0.25

Shift-RMB select the end of the fillet radius and 
join it to the chamfer with an edge F.

Shift-RMB select the 11 vertices of the top 
profile.

Go into front view NumPad 1. 

In the Mesh Tools panel set Degr:360 and Steps:36 
and Spin the top profile. 

Blender - Precision Modelling Guide 
By: Robert Burke www.rab3d.com - 107 -



We are now left with a series of breaks in the mesh 
between the top profile and nut sides. To keep the mesh 
organised its best to manually fill these areas.

Select 4 vertices (3 on the corners of the openings) 
corresponding to where a face should be and press 
F to insert a face. Continue around the perimeter of 
the nut until all faces are filled. 

In Edge Select mode Alt-RMB select the bottom edge of 
the nut, then Shift-RMB select the 6 corner edges. We 
will add a 0.1mm chamfer to these using the Bevel Centre 
script described in 608 Part-4. 

To finish add an Edge Split modifier, but because 
the edge angles are 30 degrees the same as the 
default settings for the modifier, ugly shading 
patterns will be created on the corners of the nut. 
Change the angle setting to 29 degrees to 
overcome this problem.

In the Link and Materials panel change the name 
to M6NylocNut

Tab into object mode and in the Outliner bring the 
other objects into view.

Save your work Ctrl-W. 

I hope you have found this a worthwhile exercise. The intention was to 
demonstrate how components can be modelled together in assemblies using 
one component to help set the location and surface geometry of the next, 
using Blenders Snap tools to accurately locate the new Object.

Part 3 will detail how to use Blenders Screw tool to generate a thread profile
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Before we can model the thread we need to understand the thread form. ISO 
Metric threads come with a Standard profile and as the V-Roller axle will use 
an M6 thread, I will describe the set-up of this size. 

Layout of a Metric Thread 

Key:

D Major Diameter
P Pitch
H Thread Height

The ISO Metric thread profile is a fairly simple shape to construct in Blender 
and with the screw tool only one instance of the thread profile is required. As 
a model engineer I am not going to discuss thread tolerances or fits in any 
detail. You should however be aware that the finished male thread profile 
(bolt) should be kept below the bold blue line of the diagram above and the 
finished female thread profile should be kept above the bold blue line, 
otherwise the two won't fit together. If you need them tolerance classes are 
defined in ISO 965-1.

For this exercise we will make the thread to the nominal profile above. To 
construct the thread only two pieces of information are required the Major 
Diameter and the Pitch. A few of the more common sizes are detailed in the 
table below. 

Major Diameter 3 4 5 6 8 10 12 16
Pitch 0.5 0.7 0.8 1 1.25 1.5 1.75 2

We will build the thread around the V-Roller axle. Open a 
new Blender project and go into front view NumPad 1. 
Append the V-RollerAxle into the scene Shift-F1 navigate to 
V-Roller.blend and select Object>V-RollerAxle. The axle will 
appear facing you in the front view. 
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The screw tool spins a profile around the Z-axis so the profile 
needs to be created and the screw operation performed in front 
view. The Axle needs to be rotated so it is vertical in the front 
view. Rotate X -90.

Tab into edit mode and Shift-RMB select the 7 vertices making 
up the left-hand profile of the threaded section. 

Copy these vertices Shift-D then Esc to leave them in place. 
Separate the copied vertices from the Object P. Its easier to 
work on the separated profile rather than the complete axle. 

Tab into Object Mode and select the profile. Tab back into 
Edit Mode.

We now need to work out the Thread height. It could be done 
with trigonometry given that the pitch is 1mm and the thread 
angle is 60 degrees. But I find it easier to do in Blender.

De-select All vertices then to the left of the axle Ctrl-LMB click 
to add a new vertex. Extrude this vertex on the X-axis 1mm. 
The thread form is an equilateral triangle so the sides of the 
thread triangle will be the same length as the pitch. 

Link select both vertices of the edge and copy them Shift-D 
on the Z-axis 1mm (the thread pitch).

Select the top left vertex of the two edges and snap the cursor 
to it Shift-s Cursor>selection. 

Then select the vertex on the other end of the edge and with 
the Pivot set to 3D Cursor Rotate it 30 degrees. 

Snap the cursor to the bottom left vertex and Rotate this -30 
degrees. 

Select All and remove doubles W. 

Select the centre vertex and Extrude it on the X-axis then scale 
it to the cursor Scale X 0. 
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In the Mesh Tools 1 panel press Edge Length and select the 
centre edge. The Edge Length shown is the Thread Height. 

Delete X the vertex on the left-hand side of the central edge. 
Select the three vertices of the thread profile and move G 
them towards the undercut at the bottom of the thread. 

If you haven't already got one open split the 3D view and 
open the Outliner. Click the eye icon for the axle to remove it 
from view.

Select the vertex on the major diameter of the thread and 
Extrude it on the X-axis -0.108mm (1/8 H) 

We can now use the snap tool to position the thread V profile.

Click on the magnet Icon on the view header. Select the 3 
vertices of the V and move them G, whilst moving hold down 
Ctrl and move the cursor towards the end vertex. The V will 
snap into position. 

We now need to add reference geometry to allow us to cut 
new vertices on the major and minor diameters.

Extrude vertex A on the X-axis

Extrude vertex B on the Z-axis as detailed, then Extrude this 
X 

-0.216mm (1/4 H) then Extrude again on the -Z-axis 
ensuring the edge crosses the V. 
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To finish the reference edges, extrude a vertex from the 
major diameter across the v. 

Select the three vertices of the V and cut Knife (Exact), 
snapping the cut Ctrl-LMB to the vertices of the major 
diameter.

Repeat the cut snapping the knife to the vertices of the minor 
diameter.

Delete the reference vertices, but ensure the top chamfered 
edge of the thread is not deleted, as this will be used to locate 
the cursor when we spin the thread. 

Add Edges F to the vertices of the major and minor diameter. 
Threads usually have a radius at the root of the thread so we 
will add a fillet.

Select the vertex at the bottom of the minor diameter and 
snap the cursor to it Shift-S Cursor>Selection.
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Shift-RMB Select both vertices of the minor diameter and copy 
them Shift-D, then Esc to leave them in place. With the Pivot in 
3D Cursor Rotate the edge -30 degrees. 

Select the vertex at the top of the minor diameter and snap the 
cursor to it Shift-S Cursor>Selection.

Again Shift-RMB Select both vertices of the minor diameter and 
copy them Shift-D, then Esc to leave them in place. This time 
Rotate the edge 30 degrees. 

Where the two edges cross is the centre point for the bottom 
fillet. Cut a vertex on the intersect Knife (Exact) and using Ctrl-
LMB to snap the cut to the rotated edge. 

Snap the cursor to the intersect and Delete the reference 
vertices. 

Select the vertex at the top of the major 
diameter and in the Mesh Tools panel set 
Degr:120 and Steps:4 Press Spin and the 
profile for one pitch of the thread will be 
created.

Select All and Remove Doubles W. 
Select the vertex on the thread centreline 
(right hand vertex on the top chamfer 
profile) and snap the cursor to it.
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De-select All vertices, then Link select the thread profile.

We need the thread to continue past the chamfer so we can later combine the 
chamfer detail to the thread. Counting the grid squares we will need 10 turns. 

In the Mesh Tools panel set Degr: 360 Steps:32 and Turns:10 
Make Sure Clockwise is not selected.

Press Screw and the thread will be formed. 

Go into top view NumPad 7. De-select All then Link select 
the centre and chamfer vertices. Delete these X. 

Select All and Remove Doubles W. 

Tab into Object Mode and in the Outliner open the eye icon 
for the axle, bringing it back into view. If necessary move the 
thread in the Z-axis to align with the axle. Close the eye for 
the thread. 

We now need to prepare the axle to accept the thread.

Go back into front view and select the axle. Tab into 
Edit Mode and select the top right vertex of the 
chamfer and copy it Shift-D moving it to the right of the 
axle on the X-axis. Extrude this vertex on the X-axis to 
the left of the axle. Repeat this on the bottom vertex 
loop of the thread section. 
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Go into edge select mode and paint a selection B B 
across the straight section of the thread.

Delete these X (edges).

Go back into vertex select mode. 

Tab into Object Mode and in the Outliner bring the 
thread back into view. RMB select the thread then Shift-
RMB select the axle. Press Ctrl-J to join them into one 
mesh. 

Tab into Edit Mode and De-select All then Link select 
the thread. With the Knife tool, cut two rows of vertices 
across the thread, Knife (Exact) and snapped Ctrl-LMB 
to the reference edges. 

De-select All then Box select the vertices below the 
bottom reference edge. Zoom in MW to make sure all 
the vertices below the edge are selected (not the 
vertices on the edge) Delete these vertices X. 

Box select the vertices above the top reference edge 
and delete these. Select the two reference edges and 
delete them.

The thread is now the correct length for the axle but 
there is still more to do. We must join the base of the 
thread to the under-cut and the top of the thread to the 
chamfer.

If you zoom in on the base of the thread you will see the 
flange that was originally on the axle sticking out past 
the edge of the thread (highlighted in green). 
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To correct this we need to manually merge the vertices 
of the original axle flange onto the corresponding vertex 
of the thread.

RMB Select a vertex on the flange then Shift-RMB select 
the corresponding vertex on the thread. Press Alt-M to 
merge the vertices and choose "At Last" from the pop-up 
menu.

Repeat this around the circumference of the axle. 

The intersect between the top chamfer and the thread is a much more 
complicated detail. Because the intersect doesn't occur on a set plane there 
are no vertices on the line of intersection. Therefore we cannot simply merge 
vertices to obtain the correct profile. The first part of combining the thread and 
chamfer will be to create a line of vertices on the intersect between the two 
sets of faces. 

Go into face select mode and box select 
the top section of thread and chamfer. 
Press Shift-H to hide all the other 
vertices. 

We can now use another of the python scripts to cut the 
vertices on the intersect of the faces. Split the 3D view and 
open a Script Window (detailed description in 608-4). With all 
the faces still selected, in the Script window click on 
Scripts>Mesh>Geom Tool and from the popup menu click on 
"intersect: face(s) (cut)". A new loop of vertices will be created 
on the intersect between the faces. Go back into vertex select 
mode, select All and Remove Doubles W. 

The Geom Tool script isn't bundled with Blender but can be 
downloaded from the Blender Website. 
http://wiki.blender.org/index.php/Scripts/Catalog
A description for loading the script is also available from this 
page.

With the new edge created on the intersect its now simply a 
matter of deleting the vertices, edges or faces that are not 
required. It sounds simple but this will test your patience and 
call on many of the editing techniques you have learned.
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Only delete X a few vertices at a time, if necessary Ctrl-
Z will undo the change. In places you may need to 
merge vertices Alt-M and other places you will need to 
add new faces F. Its also worth noting on one side of the 
axle the thread intersects the chamfer in two places.

As a new user this may take a fair amount of time, but 
as your experience grows this will only take a few 
minutes and the end result is well worth the effort. 

Once complete press Alt-H to bring back all the hidden 
vertices. Select All, Remove Doubles W and Set Smooth 
W. 

That completes the top thread. Rather than repeating all that work on 
the bottom thread we can simply copy the top one and reposition the 
copy to complete the axle. 

In front view Box select the thread vertices, then loop select 
Shift-Alt-RMB the inner loop of vertices on the undercut 
next to the main body of the axle.

Copy these Shift-D and move them to the side. 

In front view Rotate the copied vertices 180 degrees. 

Separate the copied thread from the axle P. Tab into Object 
Mode, Select the copied thread and then Tab back into Edit 
Mode.

Select the top row of vertices and snap the cursor to them 
Shift-S Cursor>Selection. 
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Tab into Object mode and in the Mesh panel click the Centre 
Cursor button. This will move the object centre to the centre of 
the top row of vertices. 

Select the axle and delete the vertices of the bottom thread. 

Alt-RMB select the inner loop of vertices where the under cut 
was. 

Snap the cursor to the centre of these vertices.

Tab back into Object Mode and select the thread. 

Snap the thread to the cursor Shift-S Selection>
Cursor. 

With the thread still selected Shift-RMB select the axle and 
joine the two objects into one Ctrl-J.

Tab back into Edit Mode, select All and Remove 
Doubles W. to complete the axle.

This axle will have 7274 vertices, compared to 
1418 vertices of the axle without the detailed 
thread.

You may also want to set up a camera and lights 
and render an image of the shaft as detailed in 
608-9.

Tab into Object Mode and save your work. 

In the next section we will do a dimensioned drawing of the V-Roller 
components.
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Most of the techniques necessary to layout an orthographic drawing were 
covered in Part 11 of the 608 Bearing Tutorial so rather than just repeating 
what's in that section this will be just a brief description of the layout process.

Initially though I thought it would be good to mention the two standard 
methods of laying out a drawing. 1st Angle Projection and 3rd Angle 
Projection. To see how the views are represented on paper it's easier to fold 
the paper into a cube around the component and project the view onto the 
cube. When the cube is unfolded it gives the correct layout. 

1st Angle Projection 

In First Angle projection the view is 
projected through the component, 
so the front view is projected onto 
the back wall and the top view is 
projected onto the base. 

When the 1st Angle view is folded 
out the front view is at the back of 
the top view and the side view is on 
the opposite side of the front view. 
This type of layout often causes 
confusion with people who aren't 
completely familiar with 
orthographic layouts. 
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3rd Angle Projection 

In 3rd Angle projection the side facing the 
cube is projected onto the cube, so the 
top view is on the top of the box and the 
front view is on the front of the box. 

In 3rd angle projection the views are 
positioned on the same side of the view 
next to them, so the top view is on top 
of the front view and the side view is on 
the side of the front view that it 
represents. This is a much easier layout 
to understand and my preferred choice. 

Hopefully that,s enough for you to appreciate the formal aspects of 
orthographic layouts, Its a subject where you can go into ever increasing 
detail and this is just a brief primer to get you started. If you want to learn 
more about layouts there is a lot of detail on www.technologystudent.com, it's 
worth a visit as it contains a lot of in depth advice.

I think that's enough on layouts so let's get back to Blender. In part 10 we 
created a page Layout for an A4 Portrait Page. We can start by importing this 
and then rotating the border to form an A4 Landscape layout. Start a new 
Blender project. If you already have Blender open save your work Ctrl-W then 
press Ctrl-X to open a new file. Delete the Cube Object that opens with each 
new project X, as we don't need it. 
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Append all the A4p objects from the PageTemplate.blend 
file created in the 608-Bearing tutorial. Shift-F1 to open 
the File Browser window in Append mode and from the 
"PageTemplate.blend" file LMB click Object then RMB 
select all the A4p objects. Click on Load Library to bring 
them into the new file. They will be placed on Layer one, 
as this was the layer they were created on. Go into front 
view to see the layout NumPad 1.

In the outliner select the A4pBorder object then in the Link 
and Materials panel change its name from A4p (portrait) to A4L (Landscape). 
Repeat this for all the other A4p Objects.

It's now time to rotate the border. The only problem is 
that the Title box is part of the Border mesh so we first 
need to separate the Title Box from the Border. Either in 
the Outliner or 3D view select the A4LBorder Object and 
Tab into Edit Mode. Select All vertices, it's easier to deselect the vertices of 
the title box than select the vertices of the Border. 

To de-select the vertices of the title box press B for box select, but this time 
drag a selection box over the vertices you need to de-select using the RMB. 
The vertices will no longer be selected. On the 3D View Header press 
select>>Inverse, this will invert the selection so the title box is now selected 
and the Border isn't. (You could have just de-selected all then box selected 
the Title Box, but I wanted to show the Box Deselect feature!) 

With the Title Box vertices selected press P (part) to 
separate them from the current mesh and choose 
"Selection" from the pop-up menu.

Tab back into Object Mode and select A4LBoundary, 
Tab back into Edit Mode and select RMB the bottom 
Right Hand vertex snap the Cursor onto this Shift-S 
Cursor>Selection.

Tab into Object Mode and RMB select the A4LBorder Object and Shift-RMB 
select the A4LBoundary Object. In the 3D View Header set the Pivot point to 
3D Cursor, then Rotate the Border and Boundary 90 degrees. 

The Border is now disjointed from the Title Box so 
Grab the Border and move it on the X-axis until the 
bottom Right Hand corner sits around the Title Box. 

The final thing to do is amend the Camera and output 
Format settings detailed in A4LText.007 so Size X 
becomes 3300 and Size Y becomes 2400.

You now have an A4 Landscape page template that can be appended back 
into the PageTemplate.blend file.
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Append the V-Roller Object from V-Roller.blend 
onto the scene and position it within the Border. 
(If it doesn't appear on the view after appending 
check the Eye icon in the Outliner is open or it's  
layer is active) Copy this Shift-D and move it 
on the X-axis to the right of the original. Rotate 
the copied V-Roller on the Z-axis 90 degrees. 
Copy the rotated V-Roller and position this to 
the right of the original. We will use the second 
copy to form a sectioned view.

Append the V-RollerAxle from the same file and position this within the 
border. Copy this on the Z-axis and position it above the original. (3rd Angle 
projection Top view sits above Front View)

Save the file as V-RollerLayout.blend 

We now need to change the material for all the components. 
Select the 1st V-Roller and In the Links and Pipeline tab of 
the Material Buttons press the X to remove its material, then 
click Add New to add a new material.

In the Materials tab set the colour to white and click 
Shadeless so it renders as a pure white colour. 

In the World Settings change the Background to white. 

With the material set on the first V-Roller Shift-RMB select all the other 
components, then Shift-RMB select the 1st V-Roller to make it the active 
object. Press Ctrl-L (Make Links) and select Materials from the popup menu. 
This will copy the material from the active object onto all the other selected 
objects. 

In the Output tab of the Scene Buttons click Edge to 
allow the Edge filter to draw an outline around the 
components and then click on Edge Settings and set 
Eint (Edge Intensity) to 1 to give lines only on the most 
prominent edges.

In the Format tab change size X to 3300 and Sixe Y to 2400. Select the 
camera, go into camera view NumPad 0 and align the camera with the 
Boundary Object. Set the Camera to Orthographic in the scene buttons 
Camera tab 
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Because we are working with such a large output 
size you can select areas of the camera view to 
do a test render. In the camera view press Shift-
B and drag a selection box over the area you 
would like to test. The render will then be 
confined to the area of the selection. 

To come out of Border render de-select Border in the Render tab. 

In side view NumPad 3 cut the right hand V-Roller in half by 
deleting all the vertices forward of the centreline. This is 
easier carried out in local view NumPad /. 

Alt-Shift-RMB select the vertices on the two open ends and 
copy Shift-D them forward of the 1/2 V-Roller on the Y-axis. 
Shift-F fill these faces, beautify the fill Alt-F and convert to 
Quads Alt-J. The faces have been separated from the V-
Roller to allow the edge filter to detect the edges cleanly.

With the vertices of the disconnected faces still selected we 
need to add an image texture with a hatch pattern. If you 
haven't already got one available use one of the textures 
from the 608-Bearing tutorial Part 11.

In the Link and Materials tab of the Editing Buttons click 
New to add a second material to the mesh and then 
press Assign to assign the second material to the 
selected vertices. 

In the Shading Buttons, Texture sub context add a new 
image texture and load your hatch pattern.

If you need more detail of how to do this go back to the 608-Bearing tutorial, 
Part 11 describes the process in detail. 

Because Image textures are stretched to fit the object's bounding box 
size the hatch will have been skewed vertically so increase Y repeat 
to 2 or 3 in the Map Image tab of the texture buttons. This will repeat 
the texture 2 or 3 times in the Y-axis.

If you do a test render you should end up with something like the 
image opposite. 
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Radial Dimensions

To construct a diameter dimension select a vertex 
either side of the horizontal centreline and add an 
edge F. Click on Edge Length in the Mesh Tools 1 
tab of the Editing Context buttons. We can use this 
figure for the dimension text.

Separate this edge from the V-Roller P, choose 
"Selected" from the pop-up menu. Tab into Object 
Mode and select the new edge, which will be used 
to form the dimension line. Go into Local view 
NumPad / for dimension line, then Tab into Edit 
Mode (Note I have removed the material to make the images clearer for this  
tutorial).

Select both vertices and Extrude them Z 0.1. Select the bottom two vertices 
and Extrude these Z -0.1 This adds thickness to the dimension line.

Select All and cut K through the horizontal edges 
choosing Knife (Multicut) from the pop-up menu 
and accepting the default 2 cut's. 

Select the six new vertices that have been cut and 
Scale them along the horizontal edges X until they 
are around 4mm from the ends of the dimension 
line. Select the two vertices A & B and Extrude them in the Z axis 1mm 
Repeat this on the other three edges. You should end up with a dimension 
line that has a box on either end. 

Select the five left hand vertices and with the Pivot 
Point set to Median Point Scale the vertices to 0 
then Remove Doubles W. You will end up with an 
arrow shaped end.

Repeat this on the other end of the dimension line.

The next requirement is to add a leader line for the 
dimension text. Select the three vertices in the 
yellow box opposite. 

Toggle back into Global View NumPad / and 
extrude these vertices on the X-axis out past the 
edge of the component.

Add the Black shadeless material from the border to the dimension line.

Tab into Object Mode and in side view NumPad 3 move the dimension line in 
front of the V-Roller. With the dimension line selected snap the cursor Shift-S 
to its object centre Cursor>Selection. 
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Insert a Text object and in the Editing buttons 
Font tab, increase its size to suit the page scale 
(4 on my layout)

Backspace through "Text" to remove it, then 
add the dimension size using the number keys 
on the main keyboard (not the NumPad keys) 

Tab into Object Mode and move G the text 
over the leader line.

Finally add the Black material to the text object.

With the cursor snapped to the Object centre copy the the dimension line and 
text, then rotate the copy from the horizontal.

The original dimension line can now be modified by moving the arrows on the 
X-axis to a new diameter. 

This technique can also be used for radius 
dimensions by cutting the dimension line on the 
centre-point and deleting all the vertices to one 
side of the cut.

If you haven't been doing so it's worth 
frequently saving your work. Press Ctrl-W and 
save the file. 
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Linear dimensions

Linear dimensions using the Blender Caliper script were 
covered in detail in the 608-Bearing tutorial Part 11 along 
with scaled views. If you can't remember how to add the 
dimensions please revisit Part 11. 

As a quick refresher, in Edit Mode select the two vertices 
where you want the dimension measurement to be taken 
from.

Copy the vertices and move them away from the model 
(constrained to an axis). This gives a break between the 
extension line and the model. Extrude these vertices to the 
point where you want the dimension line, then extrude 
again past this point.

To thicken each edge so it will show on the render, select 
the three vertices of one edge and extrude it away from the 
other edge 0.2mm. Do the same with the other edge. 

To add the dimension select the two vertices on the inner 
edge of the extension lines. Open Blender Caliper, adjust 
the measurement settings for the dimension line and press 
measure. (You may need to play with the settings to get a 
suitable font size and dimension line scale).

Select the vertices of the extension lines and separate 
them from the models mesh P. Go into Object Mode and 
join the extension lines to the dimension line created by 
Blender Caliper by selecting both objects and pressing 
Ctrl-J. 

As you progress through your layout join all the dimension 
and extension lines into one object. It helps to change the 
colour of the dimensions to help differentiate them from the 
model. 
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The models are going to be rendered using the edge 
settings so need to be rendered separately to the 
drawing border and dimensions. Select all the models 
and move them onto layer 2 Move then click the second layer box in the pop-
up. 

In the Render Layer tab of the scene 
buttons select layer 2 to limit the render 
to this layer. In the Output tab make sure 
Edge is still selected.

In the Format tab select PNG as the file 
format and check the RGBA button. 
Render the line drawings of the 
components. When you save the render 
it will save the component layout onto a 
transparent background. Save F3 the 
drawing as V-RollerLayout1.png 

To combine this drawing with the border and dimensions, we 
can use the Node Editor. The Node editor is a complex image 
editor and needs a book of its own to describe its full 
capabilities. I will just touch on what's needed to combine the 
two layers.

In the render Layers tab select layer 1. In the Output tab 
deselect Edge to turn off the edge filter. Render the layer and 
close the render window.

In the 3D View click the window type button and choose 
Node Editor. On the Node Editor Header click on the face 
icon to select composite nodes, then click Use Nodes. A 
Render Layer Node and Composite node will appear in 
the view joined with a curved line. 

The nodes will have a thumbnail view of the Border and 
Dimensions. We now need to add an input node so we 
can load the image with the line drawings. 
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Press the SpaceBar to open the node menu choose 
Add>Input>Image, a new node will appear in the 
View. You can move the nodes around by LMB 
dragging the Header at the top of the node. Position 
the Input Node below the Render Layer Node.

Press Load New and load the drawing V-
RollerLayout1.png. The thumbnail of the image will 
appear in the node. Nodes are arranged with inputs 
on the left-hand side and outputs on the right-hand 
side. 

We now need to add a node that can 
combine both the Render Layer and Image 
nodes together. To do this press the 
SpaceBar and choose 
Add>Color>AlphaOver. The AlphaOver node 
will be placed in the view. 

We need to re-wire the nodes to 
give us the correct output.

LMB click and drag the cursor 
across the link between the 
Render Layer Node and the 
Composite Node. This will cut the 
connection.

LMB click and hold on the yellow 
output socket on the Render 
Layer node and drag the mouse 
to the bottom yellow input socket 
on the Alpha Over node. A new 
connection will be made. 

In the same way connect the output of the image node to the top input of the 
Alpha Over node. Then connect the Output socket of the Alpha Over node to 
theinput socket of the Composite node. The connections are now complete.
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Before rendering the layout you must tell Blender to use the composite output. 
In the Scene buttons Anim tab click Do Composite, then render the layout. 

If all has gone well you will get a composite layout with a dimensioned line 
drawing of the components. In the Scene buttons Format tab Click RGB as 
we no longer need alpha in the image and Save the Layout drawing F3. Save 
your file Ctrl-W. 

The final thing necessary to print the drawing to scale, is to adjust the pixels 
per inch to 300 in an image-editing program such as Gimp or PhotoShop. 
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By now you should be fairly familiar with Blenders modelling capabilities. The 
608 Bearing and V-roller tutorials have covered most of the commonly used 
tools and techniques, so this won’t be so much of a tutorial as a discussion on 
the steps needed to use Blender as a tool to help you design a casting. As the 
next stage of my CNC router upgrade is to redesign the X-axis slides I will use 
this as the motive for designing the casting. We will again reuse the bearing 
and V-roller as the building blocks for the casting layout.

There are many casting techniques that could be used for this component 
such as sand casting, die-casting and centrifugal casting, but because of my 
limited workshop facilities and the availability of a pottery kiln, I have chosen 
to use the investment casting technique. This is where a wax model of the 
part is fabricated then dipped into a refractory slurry which is dried, the wax is 
melted out leaving the refractory casing which when fired becomes the mould 
for the molten aluminium. The mould is then broken away from the aluminium 
when it has cooled.

The benefit of this method is you can produce an accurate wax model without 
worrying too much about withdrawal tapers or undercuts, If you can make the 
component in wax you should be able to produce an investment mould from it. 
I will go into a little more detail about the mould making and casting process in 
the foundry section. Here I will concentrate on using Blenders modelling 
capabilities to design the casting. 

If you haven’t already got blender running 
this is the time to start it up? Delete the 
default cube X and then append into the 
scene Shift F1 the V-Roller, bearings, 
shaft, nut and washer assembly created in 
the V-Roller tutorial. They will be placed 
into the scene rotated so the roller will run 
along the X-axis. Go into side view 
NumPad 3 as we need to add a shaft for 
the V-Roller to run along. To make sure the 
shaft is centred to the V-Roller, select the V-roller and in the Edit Buttons click 
“Centre New” this will ensure the object centre is on the centre of the V-Roller. 
We can now snap the cursor to the V-Rollers object centre Shift-S 
Cursor>Selection. 

Add a cylinder to represent the shaft 
SpaceBar Add>Mesh>cylinder and in the 
pop-up menu set Vertices: 32, Radius: 9, 
Depth: 100. In its current position the shaft 
penetrates through the V-Roller so we need to 
move it down so that the shaft sits below the 
‘V’.
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Tab into Object Mode then Grab the shaft and 
move it on the Z-axis until it sits just below the 
V-Roller. Zoom in fully and repeat this if 
necessary to get the closest possible alignment.
You can also zoom into a selection box by 
pressing Shift-B and dragging a selection box 
over the zoom area you require.

In front view NumPad 1, Tab into Edit mode 
and Box select the right-hand vertices. Move 
these vertices G along the X-axis 300mm. This 
will make the shaft 400mm long. Tab back into Object Mode. 

It's possible to have the V-Roller rigidly aligned 
to the X-axis using just 3 rollers, as I am going 
to reuse this set-up on other areas of the 
machine I am going to use 4 rollers. In front 
view NumPad 1, Box select the V-Roller 
assembly and copy it Shift D. Move it along the 
X-axis 150mm. Now Box select both V-Roller 
assemblies and copy them Shift-D, moving the 
copies on the Z-axis until the ‘V’ is below the shaft. In side view NumPad 3 
Zoom in close to position them as accurately as possible 

Its not feasible in a home workshop to make 
components to micron accuracy so some form 
of adjustment will be necessary to position the 
V-Rollers tight to the shaft. I am going to fix the 
top two rollers into the main casting, but allow 
the bottom rollers to be adjusted on the Z-axis. 
For this I will use a simple rebated block with 
elongated bolt holes. This can simply be 
located within a rebate in the main casting. 

The Adjuster Block 

To make the adjustable block, RMB select the 
bottom right hand V-Roller axle and go into 
Local View NumPad /. Select Shift-Alt-RMB 
the loop of vertices at the back of the fillet and 
snap the cursor to the centre of them, Shift-S 
Cursor>Selection. This gives us the location 
point for the adjuster. Go into Object Mode and 
in front view Insert a mesh circle, SpaceBar 
Add>Mesh>Circle, in the pop-up menu set 
Vertices: 32. and Radius: 3. 
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Whilst still in Edit Mode add a Plane and Scale it by a 
factor of 22 to give a 44mm square. Delete the face 
from the plane X “Only Faces” then subdivide the 
edges 7 times. W “Subdivide Multi” and set 7 in the 
popup menu. This will give our outer square the same 
number of vertices as the inner circle. Add faces 
between the inner circle and outer square by pressing 
F and selecting "Skin Faces/Edge Loops". Select all 
and Extrude "Region" along the Y-axis 10mm, to add 
thickness to the component. 

In order for the adjuster block to be able to be 
positioned in the casting it needs some side flanges 
that will also incorporate the elongated bolt holes. In 
side view NumPad 3 cut a loop of vertices K 
"Midpoint". Grab the new loop of vertices and move 
them on the Y-axis -2mm, this will give us a 3mm 
face to form the flange from.

Select the flange face's, one side at a time and 
extrude them 10mm. The top and bottom flange will 
shield the components of the slide from dust produced 
by the router. 

Delete the two corner faces indicated, X "Faces" on 
each of the corners. Make sure the edge between the 
two faces is also deleted.

Select the vertex indicated and snap the cursor to it. 
Shift-S Cursor>Selection. Then select the four vertices 
from one of the deleted faces.

In front view spin a corner radius with five vertices. 

When all the four corners have been spun Select All 
and remove doubles W. 
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We now need the centre line of the flange to position the 
elongated bolt holes. It can't be loop cut because the 
corner faces are triangles. 

Use the Knife tool (Midpoints) and cut the loop indicated. 

To add a chamfer to the edge of the adjuster loop cut 
Ctrl-R the outer loop of faces. With the Edge Length 
button activated, slide these to 0.5mm from the edge. Do 
this on the front and back of the flange. 
Now select the front outer edge loop and move it 0.5mm 
on the Y-axis. Do the same on the back outer edge but 
move this -0.5mm. 

Snap the cursor to the middle of the two vertices shown.

In front view add a circle, Vertices: 16, Radius: 2.2 (clearance for 
a 4mm bolt). 

Copy the vertices from the circles centreline and above and 
move the copy 4mm on the Z-axis. Then copy the vertices of the 
circle from the centreline and below moving them -4mm on the Z-
axis.

Delete the original circle and the flange vertices closest to it.

This leaves you with the outline of the slot positioned centrally on 
the flange. 
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Alt-RMB select the vertices of the elongated hole, then 
Shift-Alt-RMB select the vertices of the flange that 
surround it. Shift-F to fill the area with faces. Alt-F to 
beautify the fill and Alt-J to convert to quads.

Copy the new faces and move them 3mm on the Y-axis. 

Shift-Alt-RMB select the two elongated slots and loft 
faces between them F "Skin Face/Edge Loops".

Select all and remove doubles. 

Select the vertices central to where the other three 
slots are required and delete them. Copy the slot 
faces and surrounding faces. and use Blenders snap 
tools to snap the copy to the other locations.

First Rotating the two left-hand copies 180 degrees.

Finally select all and remove doubles to complete the 
adjuster. 

Once the flange is complete go back into 
Global view NumPad / and copy the 
adjuster to the other V-Roller

Shift-D X -150 
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The Lead Screw & Roller-nut 

WE have now got the locations for the fixed rollers and the adjuster blocks. A 
few other components are needed on the casting because it will also hold the 
lead screw roller-nut. 

I am using an M16 threaded rod as the 
lead screw and have designed a simple 
roller-nut based on the V-Roller and axle. 
It’s simply a series of slots at 2mm pitch 
to marry in to the M16 thread.

To stop the lead screw from flexing away 
from the nut a couple of bearings will be 
located above the lead screw and offset 
slightly to either side of the centreline. 
These bearings will use a shortened 
version of the V-Roller axle. 

The roller-nut and bearings will also need to be adjustable, 
so the brackets that hold them back to the main casting will 
also need to allow some movement in the Z-axis. 

My CNC machine is configured with two X-axis slides, one 
either side of the table. The Y-axis runs between them 
forming a bridge type layout. The X-axis therefore also has 
to locate the mounting points for the Y-axis. If you have a 
look at the photos of my old machine on the CNC page at 
www.rab3d.com this will make more sense.

At this stage of the design, things are very flexible, none of the component 
positions are fixed and it's easy to move things around to optimise their 
location. 

We have now accounted for all the parts of the X-axis, so in part-2, I will start 
constructing the main casting around them. 
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We now have all the components needed for 
the X-axis roughly positioned. So it's time to 
put a little thought into what shape the casting 
needs to be to accommodate the components. 

In front view the components are fairly spread 
out and could possibly be moved closer to the 
centre to reduce the footprint of the X-axis. 

In side view its clear that some of the components will penetrate 
the front mounting face of the casting. It will be necessary to 
provide a recess behind the roller nut and top right hand bearing.

The size and location of the recesses will determine how close 
the other components can be to the centre of the casting. 

The first part of the casting to model is the 
recess behind the Roller-nut. To make modelling 
easier you can hide the slide shaft and lead 
screw by clicking the eye icon in the Outliner. 
Select an adjuster block and in Edit mode snap 
the cursor to the front face of one of the adjuster 
blocks. Tab into Object mode and in front view 
add a plane. In object mode move the plane 
central to the Roller nut and resize it so it is 
larger than the nut. One side should be aligned 
with the back of the axle flange.

Delete X Only Faces to remove the face from the 
plane 

Extrude the four edges Y 8mm. This will add depth to the 
recess.

In side view Grab the top back vertices and move them, Z 
-8 mm to give a 45 degree angle. Move the bottom vertices 
up 8mm. 
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In top view move the back side vertices in 1mm to add a 
withdrawal taper.

Finally add a face to form the back wall. 

I have repeated the process for the top Right-hand 
bearing. This time making a little extra room for the axle 
and nut which also penetrate the front plane of the 
casting.

With the two recesses modelled it's easy to see where 
the rest of the components can be repositioned to make 
the casting more compact. 

Theirs plenty of room to allow me 
to move the V-roller centres from 
150mm to 110mm. It's also 
apparent the Adjuster blocks are 
larger than they need to be so I 
will reduce their size. 
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Select one of the adjuster blocks and Tab into edit 
mode. It's not possible to just scale everything to a 
smaller size because this will also resize the centre 
hole, slots and flange widths. So I need to resize it in 
stages. 

The square centre hub is 44mm and I am going to 
reduce it to 36m. Box select the centre hub and 
flange vertices directly above and below it. Scale this 
on the X-axis by 1.2222 (44 / 36). 

Now box select the vertices of the right hand flange 
and move G these on the X-axis -4mm (1/2 the 8mm 
difference). 

Repeat this with the left-hand flange. Moving it 4mm 
on the X-axis.

Box select the vertices of the centre boss and the 
flange vertices directly to the left and right of it and 
again scale this 1.2222 but on the Z-axis. Then grab 
and move the top and bottom flanges 4mm.

You should now have a square adjuster block. 

In scaling the adjuster on the Z-axis we have also just 
scaled the slotted bolt holes. These need to be returned to 
their original size. We can do this by scaling the vertices of 
the slots by the inverse of the original scale (1 / 1.2222 = 
0.81818).

Select the vertices of the first slot and Scale it Z 0.81818 
Repeat this on the other three slots. 

Finally scale the centre hole on the X and Z-axis 
by the same amount to return the hole to the 
correct diameter. (Scale Shift-Y 0.81818) 

With the adjuster blocks reduced in size I have 
been able to further reduce the V-roller centres, 
which are now 100mm apart. I have also moved 
the bottom V-rollers in 6mm so the edge of the 
adjuster blocks are level with the outside of the 
top V-roller's. 
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To form the pockets in the casting where the adjuster blocks sit we 
can copy both adjuster blocks Shift-D then press Escape to leave 
them in position. We can then cut and adapt the copied adjuster 
blocks mesh to form the adjuster locations in the casting.

With the copied blocks still selected go into local view NumPad /. 
In side view select the front face of the adjusters. Snap the cursor 
to the selection so it's on the same plane as the front face, then 
delete the vertices.

Because of the chamfer the front loop of vertices is no longer 
aligned on to the front face of the casting. Loop select the front 
edge and in cursor select mode Scale the vertices on the Y axis to 
0. This will bring the edge back into alignment. 

Select and delete the vertices of the central hole, to leave us 
with a recess the same shape as the adjuster. 

If it were left like this there wouldn't be any room for the 
adjuster to slide on the Z-axis. So we need to mover the top 
and bottom flange to allow the adjuster to move.

Select the vertices of the top flange and Grab them 
moving them on the Z-axis 4.5mm. Move the bottom 
flange -4.5mm. This will give us the room for the 
adjuster block to move up and down. 

The adjusters will be secured with a 4mm bolt, so the casting 
needs a 4mm-tapped hole centrally to the slot.

It's not practical to model the thread so it will simply be 
represented by a hole at the tapping drill size, which is 3.3mm.

Select the four vertices from the straight edges of the slot and 
snap the cursor to their centre. Add a circle with 16 vertices and a 
radius of 1.65mm. 

Blender - Precision Modelling Guide 
By: Robert Burke www.rab3d.com - 139 -



Delete the vertices of the slot then rebuild the faces around the 
hole. 

 

Using Blenders snap tools, copy and paste the hole and 
surrounding faces to the other locations.

At this stage it will also be good to delete unnecessary 
vertices and rebuild the faces as larger quads.

Blenders skin Face/Edge Loop feature will be useful for 
this. 

Once one adjuster recess is complete, copy it and move 
it 88mm on the X-axis so it sits behind the other 
adjuster.

To position the fixed axle holes, RMB select a fixed axle and go into Local 
View NumPad /. Select Shift-Alt-RMB the loop of vertices at the back of the 
fillet and snap the cursor to the centre of them, Shift-S Cursor>Selection. This 
gives us the location point for the adjuster. Go into Object Mode and in front 
view Insert a mesh circle, SpaceBar Add>Mesh>Circle, in the pop-up menu 
set Vertices: 32 and Radius: 3. Repeat this for the other axle.
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Select the axle location circles, the 
pockets behind the roller-nut and 
bearing and the adjuster recesses 
and combine them into one mesh, 
Ctrl-J.

These are the first features of the 
casting.

In order to locate the roller-nut and 
bearings, three adjuster brackets are 
required. I will construct these in Part-
3. This will then allow me to add their 
mounting locations to the casting.
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To finish off all the mounting locations on the 
casting, we need three more components, the 
mounting brackets for the Roller-nut and 
support bearings. Because the design of the 
brackets relies on the position of the casting 
face from the axle centres and also any 
pockets in the casting, it has not been 
possible to design the brackets until now.

Hide all the components other than the 
Roller-nut assembly, casting and lead screw. 
It will be easier to see the available space for 
the bracket without the other components.

Tab into Edit Mode for the casting and snap the cursor to the front face. I have 
selected the two vertices of the recess, so the cursor is on the edge of the 
recess and aligned with the mounting face of the axle. 

Back in Object Mode, add a Plane. Scale the left-hand side 
vertices to the cursor, its height to 30mm and width to 4mm. 
Extrude the right hand vertices on the X-axis 6mm then again on 
the X-axis 10mm, the 6mm section will be used to form a 
locating key, the 10mm section will become the bolt flange. 

Extrude the three faces to give a thickness of 3mm. 

Tab into Edit Mode for the axle and snap the cursor to the 
vertices on the flange fillet as detailed in Part 1. Tab back 
into the adjuster Bracket.

In side view add a circle with 32 vertices and a 3mm radius.

Extrude these vertices then press Escape to leave them in 
position. cale the extruded vertices by a factor of 4 to give a 
24mm flange. 

Delete some of the vertices from the outer circle and add 
edges back to the mounting flange. With careful choice you 
can get a tangential alignment.

Midpoint cut a row of vertices on the mounting flange and 
delete the vertex that would become inside the bracket. This 
will remove four faces from the mounting.

Rebuild new faces around the hole. 

Blender - Precision Modelling Guide 
By: Robert Burke www.rab3d.com - 142 -

Designing a Casting Part-3 The Roller-Nut Mounting Brackets

file:///I:/Rob/Web Site/tutorials-cast1.html#centre


Select the vertices indicated and Extrude them on the X-
axis 4mm then again 6mm. 

In wire view delete the vertex that has been created 
internal to the bracket. Select all and remove doubles.

You will also need to rebuild the faces of the original 
face, as these will be removed by the extrusion process. 

As detailed in Part-1 for the V-roller adjuster brackets 
add two elongated holes to the flange and also a fillet to 
the outer corners.

Finally the bracket needs to be constrained to a 
movement perpendicular to the lead screw. 

To achieve this I have purposefully created vertices that 
will allow the incorporation of a key, which will be 
located in a slot machined into the face of the casting. 

Select the two faces indicated and extrude them 2mm. 

The support bearing adjusters are modelled in a similar 
way to the Roller-nut adjuster bracket. I have slimmed 
down the bracket to 6mm and moved the mounting 
flange above the bearing. 

The right hand adjuster will be set back into the pocket 
provided in the casting. 
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The view from the back shows the 6mm key, which 
penetrates the face of the casting.

Some work will be required to provide the mating slot in 
the casting and the bolt holes. 

The left-hand adjuster stands out further from the casting 
to allow support forward of the lead screw centreline. 
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Transferring Geometry to the Casting 

Select an adjuster and Tab into Edit Mode. In top view 
NumPad 7 select the vertices on the back face of the 
adjuster. 

Copy the vertices Shift-D then Escape to 
leave the copy in place. Separate the copy 
from the adjuster mesh P.

Tab into Object Mode and select the copied 
adjuster face, then Shift-RMB select the 
casting. Join the copied face to the casting 
Ctrl-J.

Repeat this for all three adjuster brackets.

Some work is now needed to modify the 
copied geometry to suit the casting. 

As with the V-roller adjuster, the lead screw adjusters will be secured with 
4mm bolts, so the casting needs 4mm-tapped holes centrally to the slot.

Again these will be represented by a hole at 
the tapping drill size, which is 3.3mm.

Alt-RMB Select the vertices from the slot and 
snap the cursor to their centre. Add a circle 
with 16 vertices and a radius of 1.65mm. 
Repeat this for all slots. 

Delete the unnecessary vertices, leaving the 
key way slot and tapped hole circles.

In order for the adjuster to move in the slot the slot 
length needs to be increased by at least the amount 
of movement available on the elongated bolt holes. 

Grab the top vertices of the slot and move them on 
the Z-axis 5mm. 
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I have also cut the slot lengthways with a mid point cut. 
This has enabled me to spin a radius at the top of the 
slot, which on the casting will be cut using a 6mm slot 
drill, giving the radius on the ends.

A mid point cut has also been made horizontally across 
the recess to align vertices with the centre vertices of the 
key slot. 

The slot on the top right adjuster poses a different problem, 
as it has to penetrate the face of the bearing recess. 

To add vertices and edges for this penetration use the Geom 
tool. Select the intersecting faces and in a script window 
choose Scripts>Mesh>Geom Tool

Select Intersect: Face(s) (Cut) 

The Geom Tool will cut a new series of edges around the 
intersection. It will also triangulate all the selected faces.

Delete all the unnecessary faces and convert the remainder 
to quads, Alt-J. 

Extend the top of the slot 5mm to allow the adjuster bracket 
room to slide.

Cut a vertical row of vertices down the slot and bearing recess, 
using the knife with a mid point cut.

Spin the top radius. 
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The left-hand adjuster slot just needs to be extended 5mm top 
and bottom.

A vertical mid point cut will allow the ends to have a radius 
spun to match the slot width. 

All the mating geometry needed to 
complete the casting has been 
accurately extracted from the 
component assembly.

In the next part I will complete the 
casting by building faces between all 
the extracted geometry elements. 
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With the location of the bolt holes, Key way slots, adjuster housings and 
recesses now positioned all that remains is to build the face of the casting 
between the edges already modelled.

However, to keep an organised mesh, it is necessary to 
build up a framework of edges, before auto filling 
individual areas.

Most of the parts we have created for the casting are 
not in horizontal alignment so a little bit of work is 
needed to provide vertices in the best location for the 
auto fill. 

Section off areas of the casting by extruding edges 
horizontally or vertically. Snap the cursor to 
existing vertices and in cursor select, Scale the 
other required vertices along their axis to 0 to align 
them.

Use Auto Fill Shift-F in aligned regions. Beautify 
the fill Alt-F and convert trie's to quads Alt-J. 

By constraining regions vertically and horizontally 
you can construct an organised mesh. The 
advantage of doing this are that if alterations are 
required to the model selection of aligned 
rectangles will be much easier than selecting 
areas of a mesh made up of disorganised 
triangles. 
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Before completing the face of the casting there is 
one other element that needs to be fixed to the 
X-axis slide. That is the support for the Y-axis.

As I have already roughed out my design I know the locating 
area for this needs to be 38mm wide.

The top section of the X-axis needs an area that the Y-axis 
can be bolted on to. To save having a left and right-hand X-
axis casting I will incorporate the mounting on both sides of 
the casting. 

As part of the casting's inner face I have incorporated a 
loop of faces around the outer edge, these will become 
a flange to help stiffen the casting and also give the 
mounting location for the Y-axis support bracket. 
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Extrude the holes and the outer edge back to give the casting 
thickness.

Once all the elements of the back face are on the correct 
alignment build faces between them in a similar manner to the 
front face. 

Because I haven't done any investment casting 
before I am not sure how thin the mould can be 
before it won't fill properly. Because of this I have 
increased the thickness behind the pockets to 4mm. 

Select the loop of faces from around the outer 
edge of the inner face. These will be extruded to 
provide a mounting point for the Y-axis and also 
offer some protection to the components of the X-
axis.

Extrude the faxes 30mm to clear the V-rollers 
then cut clearance holes for the lead screw and 
guide shaft. 
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This completes the casting for the X-axis 
of my CNC router. All that remains is for 
me to make a wax pattern, which will be 
fabricated, from templates printed at a 
scale of 1 to 1 from the Blender model.

This model is constructed at finished size. 
Extra metal will be required on the areas 
that are to be machined.

I will detail the progress of the casting in 
the Engineering section of my web site. 

This is the final part of the Engineers Guide to Blender. Hopefully you have 
been able to understand the processes introduced in the Guide and will be 
able to build on your experience by producing designs of your own.

If you were new to Blender when you started the guide and have worked 
through to this final page, you should now be comfortable with Blenders way 
of modelling. Theirs still a lot to learn and many more tools and techniques 
available to improve your modelling skill. How you progress from here is up to 
you, but the Internet community offers numerous tutorials and guidance, so 
you have no excuses for not progressing and becoming a Blender pro.
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